## Contents

### Preface

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience</td>
<td>vii</td>
</tr>
<tr>
<td>Accessing Oracle Communications Documentation</td>
<td>vii</td>
</tr>
<tr>
<td>Related Documents</td>
<td>vii</td>
</tr>
<tr>
<td>Document Revision History</td>
<td>viii</td>
</tr>
</tbody>
</table>

### 1 Introduction to the Order Control Application

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCA Components</td>
<td>1-4</td>
</tr>
<tr>
<td>Provisioning Management</td>
<td>1-4</td>
</tr>
<tr>
<td>Events</td>
<td>1-5</td>
</tr>
<tr>
<td>Changing Your Password</td>
<td>1-5</td>
</tr>
<tr>
<td>Changing the Date or Time Format</td>
<td>1-6</td>
</tr>
</tbody>
</table>

### 2 Creating Work Orders Using the Order Control Application

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting the OCA Session</td>
<td>2-1</td>
</tr>
<tr>
<td>Adding Header Information</td>
<td>2-1</td>
</tr>
<tr>
<td>Adding CSDLs</td>
<td>2-3</td>
</tr>
<tr>
<td>Adding CSDL Parameter Values</td>
<td>2-4</td>
</tr>
<tr>
<td>Specifying Work Order Details</td>
<td>2-6</td>
</tr>
<tr>
<td>Adding Extended Work Order Properties</td>
<td>2-8</td>
</tr>
<tr>
<td>Adding Global Parameters</td>
<td>2-9</td>
</tr>
<tr>
<td>Clearing Work Order Information</td>
<td>2-10</td>
</tr>
<tr>
<td>Submitting Work Orders</td>
<td>2-10</td>
</tr>
<tr>
<td>Creating Similar Work Orders</td>
<td>2-11</td>
</tr>
<tr>
<td>Subscribing to Work Order Events</td>
<td>2-11</td>
</tr>
<tr>
<td>Using Work Order Templates</td>
<td>2-12</td>
</tr>
<tr>
<td>Using the Order Entry Wizard</td>
<td>2-13</td>
</tr>
</tbody>
</table>

### 3 Managing Work Orders Using the Order Control Application

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searching for Work Orders</td>
<td>3-1</td>
</tr>
<tr>
<td>Defining Query Criteria</td>
<td>3-1</td>
</tr>
<tr>
<td>Wildcard Characters</td>
<td>3-4</td>
</tr>
<tr>
<td>Using Date and Time Properties</td>
<td>3-4</td>
</tr>
<tr>
<td>Selecting Sessions</td>
<td>3-5</td>
</tr>
<tr>
<td>Running Queries</td>
<td>3-5</td>
</tr>
</tbody>
</table>
Managing Fallout Work Orders Using the Order Control Application

Determining the Cause of Work Order Failure

4-1
### 5 Using the Audit Log in the Order Control Application

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searching the Audit Log</td>
<td>5-2</td>
</tr>
<tr>
<td>Selecting a Session</td>
<td>5-2</td>
</tr>
<tr>
<td>Searching the Audit Log</td>
<td>5-2</td>
</tr>
<tr>
<td>Search Criteria</td>
<td>5-3</td>
</tr>
<tr>
<td>Search Results</td>
<td>5-3</td>
</tr>
<tr>
<td>Wildcard Characters</td>
<td>5-4</td>
</tr>
<tr>
<td>Running Queries</td>
<td>5-4</td>
</tr>
<tr>
<td>Saving Queries</td>
<td>5-5</td>
</tr>
<tr>
<td>Saving a Default Query</td>
<td>5-5</td>
</tr>
<tr>
<td>Canceling Queries</td>
<td>5-5</td>
</tr>
<tr>
<td>Managing Search Results</td>
<td>5-5</td>
</tr>
<tr>
<td>Filtering and Unfiltering Search Results</td>
<td>5-6</td>
</tr>
<tr>
<td>Sorting Search Results</td>
<td>5-6</td>
</tr>
<tr>
<td>Exporting Search Results to a File</td>
<td>5-6</td>
</tr>
</tbody>
</table>

### 6 Setting Up Event Notifications in the Order Control Application

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscribing to Events Management</td>
<td>6-1</td>
</tr>
<tr>
<td>Viewing Event Notifications</td>
<td>6-2</td>
</tr>
</tbody>
</table>

### 7 Using ASAP Reports

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Standard ASAP Reports</td>
<td>7-1</td>
</tr>
<tr>
<td>Installation Overview</td>
<td>7-6</td>
</tr>
<tr>
<td>Installing and Configuring BI Publisher</td>
<td>7-6</td>
</tr>
<tr>
<td>Installing BI Publisher</td>
<td>7-6</td>
</tr>
<tr>
<td>Setting Up Users for SARM and ADMIN Databases</td>
<td>7-6</td>
</tr>
<tr>
<td>Configuring JDBC Data Sources</td>
<td>7-7</td>
</tr>
<tr>
<td>Installing ASAP Report Templates</td>
<td>7-8</td>
</tr>
<tr>
<td>Uploading and Configuring ASAP Reports</td>
<td>7-8</td>
</tr>
<tr>
<td>Viewing ASAP Reports</td>
<td>7-9</td>
</tr>
<tr>
<td>Exporting Reports</td>
<td>7-9</td>
</tr>
<tr>
<td>Printing Reports</td>
<td>7-10</td>
</tr>
</tbody>
</table>
Preface

This guide provides an overview of Oracle Communications ASAP Order Control Application (OCA), contains instructions for creating and managing work orders using OCA, and gives information on using audit log and setting up event notifications in OCA. This guide also explains how you can implement Oracle Business Intelligence Publisher to generate reports for ASAP.

Audience

This document is intended for system administrators, system integrators, and other individuals who need to maintain and work with ASAP.

Accessing Oracle Communications Documentation

ASAP documentation and additional Oracle documentation (such as database and WebLogic Server documentation) is available from the Oracle Help Center website:

http://docs.oracle.com

Additional Oracle Communications documentation, including ASAP developer documentation, is available from the Oracle software delivery Web site:

https://edelivery.oracle.com

Related Documents

For more information, see the following documents in the Oracle Communications ASAP Release documentation set:

- Oracle Communications ASAP Release Notes
- Oracle Communications ASAP Concepts
- Oracle Communications ASAP Installation Guide
- Oracle Communications ASAP System Administrator’s Guide
- Oracle Communications ASAP Service Request Translator User’s Guide
- Oracle Communications ASAP Security Guide
- Oracle Communications ASAP Server Configuration Guide
- Oracle Communications ASAP Cartridge Development Guide
- Oracle Communications ASAP Developer’s Guide
**Note:** To download the *Oracle Communications ASAP Developer’s Guide* from the Oracle Software Delivery Cloud site, you must select *Oracle Communications ASAP Developer Documentation Pack*. You can visit the Oracle Software Delivery Cloud site located at: [http://edelivery.oracle.com](http://edelivery.oracle.com)

### Document Revision History

The following table lists the revision history for this guide:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E61081-01</td>
<td>July 2015</td>
<td>Initial release</td>
</tr>
<tr>
<td>E61081-02</td>
<td>March 2017</td>
<td>Removed specific BI Publisher version number and directed users to the <em>ASAP Installation Guide</em> for specifics.</td>
</tr>
</tbody>
</table>
Introduction to the Order Control Application

The Oracle Communications ASAP Order Control Application (OCA) is a Java-based GUI that communicates with the OCA Service Request Processor (SRP) server. OCA is commonly used to perform fallout management; however, you can also use it to perform ASAP work order queries and submit new ASAP work orders.

The OCA is available as a stand-alone application or as an applet that can be run in a browser and embedded in an HTML Web page.

For information on installation and configuration, contact your system administrator or refer to ASAP Installation Guide.

You can extend the functionality contained in the ASAP OCA client to support your business requirements.

To open OCA as a standalone application:

1. Double-click the OCA icon on your desktop.
   - The Logon dialog box appears.

2. In the Name field, enter your name.

3. In the Password field, enter your password.

   Note: The first time you log in to OCA, the user name is ASAP_admin and the password is password_ASAP_admin. Users with the appropriate access privileges can change the default user name and password using the WebLogic Console.

4. Click OK.
   - The OCA Console window appears.

5. Expand the OCA Console window to display informational and error messages.
The OCA Console window is the point of access to all OCA functions.

To start OCA as an applet:

1. Open a Web browser and enter the following:

   http://hostname:port/Environment_ID/OCA

   where:

   - *hostname* is the name of the server where Oracle WebLogic Server is running for ASAP.
   - *port* is the port number where Oracle WebLogic Server is running for ASAP.
   - *Environment_ID* is the ASAP environment. An ASAP system can have multiple ASAP instances with multiple environments.

   The OCA Web Client Configuration screen appears.
2. Ordinarily, there will only be one registered server session. In the event that multiple server sessions are available, select the appropriate servers that you want to use, and optionally configure the session parameters. Any given OCA client can have sessions to multiple OCA SRP servers, distributed over one or more ASAP instances.

3. In the Server Session Configuration section, you can modify the following fields:

Table 1–1 Server Session Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle Timeout</td>
<td>Maximum idle time, in minutes, after which the OCA SRP server terminates the OCA client connection. Set to 0 to disable this feature.</td>
</tr>
<tr>
<td>Events Supported</td>
<td>The flag should be set to false when connecting to servers on the HP10.20 platform. Events are not supported on this platform.</td>
</tr>
<tr>
<td>Max Open Windows</td>
<td>The number of detail windows a user can have open at one time</td>
</tr>
<tr>
<td>Language Code</td>
<td>Language code for the language in which translatable information is returned to and displayed by the client. If applied, all translatable fields are shown in the OCA client native language, as specified by the LANGUAGE variable.</td>
</tr>
</tbody>
</table>

4. Click Launch Selected Server Sessions.

The following security warning appears. This is a MetaSolv-specific digital certificate.
5. Click **Grant this session** (this certificate will appear on subsequent accesses) or **Grant always** if you want to grant this session until the certificate expires and is no longer valid.

The Logon dialog box appears.

6. In the **Name** field, enter your name.

7. In the **Password** field, enter your password.

8. Click **OK**, which starts the OCA applet.

**OCA Components**

The OCA Console window provides access to the following functions:

**Provisioning Management**

- **Work Order Query**: The Work Order Query window enables you to:
Changing Your Password

Your system administrator uses the WebLogic Console to manage user and group security.

Events

Work orders can fail due to a number of factors. Failed work orders must be analyzed to determine the cause of the failure.

The Events function of the OCA contains:

- **Events Management**: Through the Event Management dialog box, you can subscribe or unsubscribe to work order notifications based on event type. You can subscribe to multiple event types.

- **Events Message Board**: Through the Event Message Board window, you can track the progress of a work order through the ASAP system without having to poll ASAP for results. The Events Message Board displays work order events occurring on the ASAP system according to the criteria defined in the Event Management dialog box. After the work order is submitted, the events appear on the Events Message Board as it is provisioned in ASAP.

Changing Your Password

Your system administrator uses the WebLogic Console to manage user and group security.
To change your password:

1. In the OCA Console, select Security, then select Change Password.
   The Change Password dialog box appears.

2. In the Old Password field, enter your current password.
3. In the New Password field, enter your new password.
4. In the Confirm Password field, enter your new password again.
5. Click OK.
   A confirmation message appears.

Changing the Date or Time Format

You can select either the MM/dd/yyyy or dd/MM/yyyy date format.

The date format affects the way date values are entered and displayed in the OCA client including in work order headers, the Work Order Query window and its results, the Work Order Release dialog box, audit logs, report generation dialog boxes, and in standard ASAP reports.

Changes to the time format apply to the Calendar tool use (for time range selection in the Work Order Query, Audit Log, and New Work Order windows).

To change the date or time formats:

1. In the OCA Console, from the File menu, select Date Format and the appropriate date format option.
2. In the OCA Console, from the **File** menu, select **Time Format** and the appropriate time format option.

Select **AM_PM TIMEZONE** if you want times specified using a 12-hour clock with an AM or PM designation. Select **TIMEZONE** if you want time specified using a 24-hour clock.
Creating Work Orders Using the Order Control Application

Create new work orders in the New Work Order window, accessed through the Oracle Communications ASAP Order Control Application (OCA) console window.

To complete a work order, you must perform the following steps:

■ Select the OCA session for work order provisioning.
■ Add header information.
■ Add Common Service Description Layer (CSDL) commands.
■ Add required CSDL parameter values.
■ Specify work order details including extended work order parameters.
■ Add global parameters.
■ Submit the work order for the required operation.

Selecting the OCA Session

If your system is configured for multiple ASAP instances, select the OCA session to provision the new work order. If you do not choose a session, the work order is provisioned in the first session listed in the OCA configuration file.

To select a session:

1. In the OCA Console, from the Provisioning Management menu, select New Work Order.
   The New Work Order window appears.
2. From the File menu, select Select Session.
   The Select Session dialog box appears.
3. From the Please select a session list, select the session you require.
4. Click OK.
   The session for work order provisioning is selected.

Adding Header Information

The Header Information section of the New Work Order window identifies the general work order parameters.
To add header information:

1. If required, edit the automatically generated work order identifier in the **WO ID** field of the New Work Order window.

2. Do one of the following to select the date and time for the work order to be processed:
   - If you use the default date and time, from the **Operation** list, select the operation that you want to perform on the work order.
   - Do the following to enter a new date and time for the work order to be processed:
     a. Click the ellipsis button next to the **Due Date** field.
        The Date/Time Properties dialog box opens. The default is the current system date and time.
     b. Select the month from the list.
     c. Select the year from the list.
     d. To select a date, click the number on the calendar.
     e. To select the time, click the time and then use the arrows.

---

Table 2–1  Work Order Header Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>WO ID</td>
<td>The work order identifier. A default work order ID is automatically generated by the system. If required, you can modify the work order ID. Maximum length: 80 characters.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The date and time that you want the work order processed. The due date defaults to the current system date and time.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the work order. The default is <strong>High</strong>. Other valid values are <strong>Normal</strong> and <strong>Low</strong>.</td>
</tr>
</tbody>
</table>
| Operation| The operation ASAP is going to apply to the work order. The values are:  
- Provisioning: Implements the existing work order.  
- Cancel Work Order: Cancels an existing work order.  
- Work Order Translation Error: For work orders that could not be processed due to error in translating the CSDL commands to Atomic Service Description Layer (ASDL) commands.  
- Hold and Review: The work order is submitted to this queue. You can use the Hold and Review queues to distinguish between work orders that must be reviewed for different reasons. For example, you can use the hold queue for work orders that require parameter values and the review queue for work orders that require other types of verification before provisioning. The Java based Service Request Processors (SRPs) do not handle the Review related request and status separately. Review will be converted to Hold in the new OCA SRP.  
- Replace Work Order: Allows an in-progress or completed order to be supplemented. This command initiates a cancellation on the in-progress service request and then starts processing a new work order. The cancelled work order will roll back (provided rollback had been specified for that order). This feature should be used with caution. In normal circumstances, the rejection of supplements for completed orders ensures that a given work order is only processed once. With this feature, it is important that the generation of duplicate work order be properly controlled in the upstream to avoid unintentional duplicate processing. |
To change from AM to PM if you have selected a 12-hour, click AM or PM and then use the arrows. For information on selecting different time formats, see "Changing the Date or Time Format."

f. Click OK.

The new date and time are entered in the Due Date field.

g. From the Priority list, select the required value.

h. From the Operation list, select the operation that you want to perform on the work order.

After completing the header information for the new work order, you can add CSDL information.

Adding CSDLs

The CSDL is a generic language for ASAP commands that are associated with particular actions from a work order. You must add one or more CSDLs to a work order.

To add CSDL information:

1. In the New Work Order window, from the CSDL menu, select Add.

   The Select CSDLs dialog box appears.

2. In the All available CSDLs list, click the required CSDLs.

   The ones you choose are automatically placed in the Selected CSDLs section.

3. To deselect a CSDL, click the CSDL in the Selected CSDLs section.

   Each selected CSDL is automatically placed in the All available CSDLs list.

4. Click OK.

   The names and descriptions of the selected CSDLs appear in the CSDL Information tab.
5. (Optional) To reorder the CSDL, select a CSDL that you want to move and do the following:

   a. From the CSDL menu, select Resequence.

      The CSDL Resequence dialog box appears.

   b. Click on the CSDLs in the left panel in the order in which you want them resequenced.

      As each CSDL is clicked, it appears in the right panel in the new sequence.

   c. To remove a CSDL from the new sequence (to correct an error), click on it in right panel.

Adding CSDL Parameter Values

CSDLs consist of parameters that are defined when ASAP is installed and configured on your system. The OCA displays the parameters that are associated with a specific CSDL. You can define the values for the CSDL parameter that are required for provisioning, but you cannot add new CSDL parameters.

You can, however, add non-provisionable CSDL parameters and values. Non-provisionable CSDL parameters are any CSDL parameters that are not used by ASAP or defined elsewhere in the provisioning translation process, but may be required to perform activities (for instance, queries) that are not directly related to provisioning. Non-provisionable CSDL parameters may be derived from upstream systems and require representation at the CSDL level.

You must add values for the required parameters before provisioning. Indexed and compound parameters are exceptions. You must add elements to them before adding
the parameter values. An index parameter has a ‘++’ following the parameter label; for example, OPT++.

The following section includes:

■ Adding CSDL parameter values used in provisioning
■ Adding elements to indexed and compound CSDL parameters
■ Adding non-provisioning CSDL parameters

To add CSDL parameter values:

1. In the CSDL Information tab of the New Work Order window, select the CSDL that you want to add parameter values to.

2. From the CSDL menu, select Update.
   
   The CSDL dialog box appears.

<table>
<thead>
<tr>
<th>CSDL Parms</th>
<th>Name</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NAME</td>
<td>Required Scalar parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DN</td>
<td>Required Scalar parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OPT++</td>
<td>Mandatory indexed parameter</td>
<td></td>
</tr>
</tbody>
</table>

3. In the Value field for the selected CSDL, do one of the following:
   ■ Enter the value for each CSDL parameter.
   ■ For the MCLI parameter, select the applicable value from the Value list.

   **Tip:** You can CTRL+click a selected CSDL to deselect it.

4. From the File menu, select Exit.

To add elements to indexed and compound parameters:

1. In the CSDL dialog box, click the Value field for the indexed or compound parameter.

2. From the CSDL Parameter menu, select Add Element.
   
   The Add Element for Index Parameter dialog box appears.
The system-generated index number appears in the **Parameter Index** field. Entering a value into this field is not allowed by the system.

3. In the **Parameter Suffix** field, enter the appropriate number, to insert an indexed compound parameter element.

   The maximum is 80 characters.

4. In the **Parameter Value** field, enter the value.

   The maximum is 255 characters.

5. Click **OK**.

   The new element name, value, and type appear in the CSDL dialog box below the CDSL index parameter.

To add non-provisionable CSDL parameters:

1. In the **CSDL Information** tab of the New Work Order window, select the CSDL that you want to add non-provisionable parameter values to.

2. From the **CSDL** menu, select **Update**.

   The CSDL dialog box appears.

3. From the **CSDL Parameters** menu, select **Add Non-Provisionable Parameter**.

   The Add Non-Provisionable Parameter dialog box appears.

4. In the **Name** field, enter the parameter name.

5. In the **Value** field, enter the parameter value.

6. Click **OK**.

   The non-provisionable parameter name and value appear in the CSDL parameter dialog box. The value in the **Type** field is **Optional parameter**, indicating that the parameter is not required for provisioning.

### Specifying Work Order Details

After you have added the required CSDLs for the work order and their parameters, you must specify work order details. In the **Work Order Details** tab, you can set the work order details that you require. In the **Work Order Details** tab, use the Extended Work Order Properties section to create work order property names and values that suit your requirements. Table 3 contains the field names and their definitions.

To specify work order details:

1. In the New Work Order window, click the **Work Order Details** tab.
2. Enter or select the applicable values in the required fields.

**Table 2–2 Work Order Detail Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent WO ID</td>
<td>If applicable, the ID of the work order that must be provisioned before the displayed work order is provisioned (maximum 16 characters).</td>
</tr>
</tbody>
</table>
| VNO_ID      | The ID of the virtual network operator. This field and its value represents an ASAP Extended Work Order Property that appears only if VNO_ENABLED is set to 1 in the ASAP.cfg file.  
The default value for this field is configurable based on the OCA SRP using VNO_ID_DEFAULT and VNO_ID_STRIP in the Service Activation Request Manager (SARM) section of ASAP.cfg.  
For more information on both of these attributes, refer to ASAP System Administrator’s Guide. |
| Workgroup   | The work group to which the work order belongs (maximum eight characters).                                                                |
| Origin      | The user or system from which this work order originated. The data is user-defined. If you do not enter a value, the system records “Unknown” in the field (maximum 64 characters). |
| Timeout     | The work order timeout interval used for this work order instead of the system-wide SARM default.                                          |
| Action      | The default value is Add. The action is used to decide the order of provisioning for future-dated orders set for the same time. The provisioning order from first to last is: Remove, Change, Add. |
Adding Extended Work Order Properties

Extended work order properties are work order properties that you create. They are different from the work order properties that are already specified as a standard part of the work order (for example, work order timeout, retry, action). Extended work order properties are only applicable to the work order where they are defined.

To define extended work order properties:

1. In the New Work Order window, click the **Work Order Details** tab.
2. From **Extended Work Order Properties**, select **Add**.

   The Add Extended Work Order Property dialog box appears.

3. In the **Name** field, enter the name of the work order property.

   The maximum is 80 characters.

   **Note:** If `VNO_ENABLED = 1` in `ASAP.cfg`, then `VNO_ID` is a reserved work order property name.

4. In the **Value** field, enter the value of the work order property.

   The maximum is 255 characters.

5. Click **OK**.

---

**Table 2–2 (Cont.) Work Order Detail Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>Set the security feature. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>■ 0: (the default) Output work order information in diagnostic files</td>
</tr>
<tr>
<td></td>
<td>■ 1: Secure work order information</td>
</tr>
<tr>
<td>Max Delay/Fail</td>
<td>The number of ASDL delayed failures before failing a batch order.</td>
</tr>
<tr>
<td>Rollback if Fail</td>
<td>In the event of failure, this identifies whether this work order is to be rolled back.</td>
</tr>
<tr>
<td>Batch Group</td>
<td>A unique number that represents the batch order. The categories of batch orders are:</td>
</tr>
<tr>
<td></td>
<td>■ Multiple orders in a batch: Multiple, independent orders grouped logically into a loosely coupled batch and activated in parallel with one another while the error threshold for the batch as a whole is maintained.</td>
</tr>
<tr>
<td></td>
<td>■ Single batch order: Set of related work orders requesting the application for the same provisioning action (for example, one switch). In effect, the single batch order is one large order with many instances in it.</td>
</tr>
<tr>
<td>ASDL Timeout</td>
<td>The ASDL timeout interval to be used on this work order instead of the system-wide SARM default.</td>
</tr>
<tr>
<td>ASDL Retry</td>
<td>The number of times the ASDL is retried in the event of failure instead of the system-wide SARM default.</td>
</tr>
<tr>
<td>ASDL Retry Interval</td>
<td>The time period in seconds between ASDL retries used on this work order instead of the system-wide SARM default.</td>
</tr>
<tr>
<td>ASDL Delay/Fail</td>
<td>Y (Yes) or N (No). Indicate whether or not hard errors encountered on the work orders are to be treated as delayed failures, therefore allowing the order to finish processing before failing.</td>
</tr>
</tbody>
</table>
The new work order property name and value are added to the Extended Work Order Property section of the **Work Order Details** tab.

6. To add more work order properties, repeat steps 2 to 5.

**Adding Global Parameters**

After you specify work order details, you can add basic or indexed global parameters. Global parameters apply particular parameter values to all CSDLs in a work order that have the same parameter. If the same parameter exists in a CSDL, the CSDL parameter is used instead of the global parameter value.

An indexed global parameter contains a sequential index element indicating that the same operation should be performed for all occurrences of that index. An indexed global parameter is identified by ‘++’ following the parameter name. For example, OPT++.

To add a global parameter:

1. In the New Work Order window, click the **Global Parameters** tab.

2. From **Global Parameters** menu, select **Add**.
   
   The Add Parameter dialog box appears.

3. In the **Name** field, enter the global parameter name.

4. In the **Value** field, enter the applicable global parameter value.

5. In the **Type** list, select the global parameter and then click **OK**.
   
   The global parameter name, value, and type are added to the **Global Parameters** tab.

6. Repeat steps 2 through 5 for each global parameter you want to add.

To add a global parameter using an existing CSDL parameter:

1. In the **CSDL Information** tab of the New Work Order window, select the CSDL.

2. From **CSDL** menu, select **Update**.
   
   The CSDL window appears.

3. Select the CSDL parameter that you want to make global.

4. From the **CSDL Parameter** menu, select **Make Global**.
   
   The selected parameter is automatically added to the Global Parameters tab.

5. Click the **Global Parameter** tab, and in the **Value** field, enter the value for each CSDL parameter you have made global.

To add an indexed global parameter:

1. In the New Work Order window, click the **Global Parameters** tab.

2. From the **Global Parameters** menu, select **Add**.
   
   The Add Parameter dialog box appears.

3. In the **Name** field, enter the indexed global parameter name.

---

**Note:** When you add a global index type, the **Value** field is disabled.
4. In the Type list, select one of the optional or mandatory indexed types and then click OK.

The indexed global parameter name, value, and type appear on the Global Parameters tab in the New Work Order window.

To add an element to the indexed global parameter that you created:

1. In the Global Parameters tab, select the indexed global parameter you created.
2. From the Global Parameters menu, select Add Indexed parameter element.

The Add Element for Index Parameter dialog box appears. The system-generated index number appears in the Parameter Index field. You cannot edit this field.

3. In the Parameter Suffix field, enter the appropriate number.

The maximum is 80 characters.

4. In the Parameter Value field, enter the value.

The maximum is 255 characters.

5. Click OK.

The new element appears below the index parameter name in the Global Parameters tab. The name of the element is a combination of the parameter name and the index number.

To change the numbering of the indexed global parameters while still retaining the same indexed global parameter order:

1. From the Global Parameters menu, select Renumber indexes.

The indexed global parameters are renumbered.

Clearing Work Order Information

If you notice that the work order contains errors, you can clear the information and start the work order over again. The Clear Work Order function clears all CSDL information, work order details, and global parameters.

To clear new work order information:

1. In the New Work Order window, from the File menu, select Clear Work Order.

A message appears confirming that you want to clear the work order.

2. Click Yes.

The new work order information is cleared.

Submitting Work Orders

When you have provided the appropriate information for the work order, you can submit it. OCA validates all work orders. A warning message appears if any required values are missing. Before the work order can be successfully submitted, you must provide any missing information.

To submit a work order:

1. In the New Work Order window, from the File menu, select Submit Work Order.

2. Do one of the following:
   - If the work order is accepted, a confirmation message appears. Click OK. The work order is submitted.
If the work order is rejected, a rejection message appears. Make the necessary changes and resubmit the work order.

**Note:** The successful submission of a work order indicates that the order has been accepted for further processing. You can check the Work Order Query window for further status updates on this work order.

3. Do one of the following:

- To create another work order by clearing the information from the work order you have just submitted, from the **File** menu, select **New Work Order**. A message appears asking you to confirm that you want to reset the work order. Click **Yes**. The WO ID field in the New Work Order window displays the new work order ID, and all other work order information is cleared.

- If you do not want to submit any more work orders, from the **File** menu, select **Exit**.

### Creating Similar Work Orders

After you submit a work order for provisioning, you can use the information for subsequent work orders. The **Similar Work Order** function maintains the CSDLs used in the work order, including the CSDL parameter values, but assigns a new work order ID number.

**Note:** For a similar work order, the due time is set to the current time. If the source work order, however, is future-dated and still in the Initial status, the due time is the same future time indicated on the source work order.

To create a similar work order:

1. In the New Work Order window, from the **File** menu, select **Similar Work Order**.
   The Similar Work Order dialog box appears.

2. In the **Enter a Work Order ID** field, enter the ID of a submitted work order and then click **OK**.
   A message appears confirming that you want to reset the order.

3. Click **Yes**.
   A new work order ID appears and the new work order includes the CSDLs, associated parameters, and work order details of the copied work order.

### Subscribing to Work Order Events

To follow the progress of a submitted work order, you can use the Events component of the OCA. You can subscribe to work order events notifications based on event type, as they occur on a specified ASAP system through the Event Management dialog box. The Events Message Board window displays all the events that occurred during the work order processing. You access the Events Message Board window from the **Events** menu of the OCA Console window.
When you no longer require work order event notifications, unsubscribe by selecting Events, then Event Management.

For more information on work order events subscription, see "Setting Up Event Notifications in the Order Control Application."

The OCA does not retain event subscription information after you log off. When you start a new session, you must resubscribe to the Events component of the OCA.

Using Work Order Templates

When you create a work order, you can save it as a template with default values for common static work order entry parameters. You can then use the template as a basis for other work orders with similar parameters. All templates are defined within a single ASAP instance.

The templates that you create are used in the Order Entry Wizard where you can submit new work orders by editing only the required parameters. You can save a template as a user or as a global template. A user template is accessible only to the user who creates the template, whereas a global template is available to all users. In addition, you can edit and delete a template.

You can also create a work order template from an existing work order. For more information, see "Saving a Work Order as a Template."

For more information on the Order Entry Wizard, see "Using the Order Entry Wizard."

To create a work order template:

1. In the New Work Order window, from the File menu, select Save as Template.

   The Template window appears.
2. The Template window displays the work order header information, CSDLs, and the parameters for each CSDL. To designate the CSDL parameters that can be modified in the Order Entry Wizard, enable the corresponding Prompt.

3. From the File menu, select Save As Template, to save a template.
   The Save Template As dialog box appears.

4. Do one of the following:
   - To restrict access to the template to yourself, click User.
   - To allow all users to have access to the template, click Global.

5. In the Template field, enter the template name and then click OK.
   The name of the template appears in the title bar of the Template window.

6. In the Template window, from the File menu, select Exit.

7. In the New Work Order window, from the File menu, select Exit.

To create a template from an existing work order:

1. Search for the work order that you want to use as a template.
   For instructions on searching for work orders, see "Searching for Work Orders."

To delete work order templates:

1. In the OCA Console window, from the Provisioning Management menu, select New Work Order.
   The New Work Order window appears.

2. Select Tools, then select Template Editor.
   The Template window appears.

3. From the File menu, select Delete Template.
   The Delete Template dialog box appears.

4. Select the appropriate template from the list and then click OK.
   A message confirming the deletion appears.

5. Click Yes.
   The template is deleted.

Using the Order Entry Wizard

The Order Entry Wizard guides you through the work order entry process. You use the templates that you have created as a basis for a new work order. To customize the new work order information, you can change global and CSDL parameters as defined by the template you created. All other parameters you predefined when you created the template.

The Order Entry Wizard dialog box consists of the following panels:

- **Select Wizard Template**: Select the template to base your new work order on.
- **Edit Work Order Details**: View and edit the header information.
- **Edit Global Parameters**: Change the global parameters for the work order as designated in the template.
Using the Order Entry Wizard

- **Edit CSDL Parameters**: Change the CSDL parameters for the work order as designated in the template.

- **Submit Work Order**: View a summary of the new work order details and submit or edit the work order. If you choose to edit the work order, the New Work Order window appears, and you can make additional changes as required before submitting the work order.

To create new work orders using the Order Entry Wizard:

1. In the New Work Order window, select **Tools**, then select **Order Entry Wizard**. The Order Entry Wizard dialog box appears.

2. To select the required template, enable **Global** or **User** and then select the template you want to use.

3. Click **Next**. The work order header information is displayed on the right.

4. If required, edit the work order header information and click **Next**. The global parameter details appear.

5. If required, edit the work order global parameters and then click **Next**. Each CSDL that is defined in the template is shown one at a time, and the name of the CSDL you are editing appears above the parameter information. Only CSDL parameters that you designated as prompted in the Template Editor are shown.

6. If required, edit the CSDL parameters and then click **Next**. The work order information summary appears.

7. Click **Submit**. The Submit Work Order message box appears, stating the work order has been successfully submitted.
Managing Work Orders Using the Order Control Application

This chapter provides information on the work order management functions of the Oracle Communications ASAP Order Control Application (OCA).

Searching for Work Orders

This section describes the methods you can use to search for work orders. You can base a search on a single criterion or a combination of criteria.

If ASAP is configured to enable Virtual Network Operators (VNOs) and your ASAP administrator has given you access privileges for VNOs, any queries you perform in the OCA client will filter work orders that contain the VNO IDs associated with your user security profile.

The options available in the window vary according to the criteria you use. Some search parameters are mutually exclusive. For example, when you enter a value in the WO ID field, all other search parameters are disabled except Max Results.

After a search has been completed, the number of work orders found appears at the bottom of the window. The search result set is truncated at the number of records specified in the Max Results field. If the maximum number of records is exceeded, you can either define additional parameters to narrow the search or increase the maximum number of results.

You can access the Work Order Query window from the OCA Console window.

---

**Note:** An out-of-memory condition can occur if your query returns too many work orders. This issue is dependent on the Java Virtual Machine (JVM) heap memory. If too many work orders are returned, increase your JVM heap memory or restrict your search.

---

Defining Query Criteria

To restrict the query to specific work orders, use as many known parameters as possible.

Figure 3–1 shows the work order query screen.
Table 3–1 lists and describes the work order query criteria you can use to retrieve work orders.

### Table 3–1 Work Order Query Criteria

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WO ID</td>
<td>The unique work order identifier. The ID that is used in this field is often the work order ID that is assigned in the requesting system. Maximum length: 80 characters.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date and time for on which provisioning on this work order was scheduled to start. For more information on using date and time properties, see &quot;Using Date and Time Properties.&quot;</td>
</tr>
</tbody>
</table>
Table 3–1 (Cont.) Work Order Query Criteria

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Limits the query to work orders with a particular status. Valid status values are:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Loading</strong>: Retrieves work orders that the Service Activation Request Manager (SARM) is receiving from a Service Request Processor (SRP).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Initial</strong>: Retrieves work orders in Initial state of provisioning.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>In Progress</strong>: Retrieves work orders currently being provisioned.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Completed</strong>: Retrieves work orders that have completed provisioning.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Stopped Wait</strong>: Temporary status of work orders stopped in progress (while rollback is occurring).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Stopped</strong>: Retrieves work orders that have been stopped during processing.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>All Failed</strong>: Retrieves all failed work orders including Failed, Failed in Translation, and Timed Out.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Cancelled &amp; Aborted</strong>: Retrieves all Cancelled, Cancelled Wait, and Aborted work orders.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>All</strong>: Retrieves work orders of all statuses.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Review</strong>: Retrieves work orders in Review state (similar to Held), Java based SRP including OCA will convert the status Review to Held before representing the work order.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Cancelled Wait</strong>: Retrieves work orders in In Progress state awaiting cancellation.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Locked</strong>: Retrieves work orders in Locked state (orders cannot be updated while in this state).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Aborted</strong>: Retrieves work orders that have been aborted.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Timed Out</strong>: Retrieves work orders that have been in progress too long and have failed.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Cancelled</strong>: Retrieves work orders that have been canceled, usually from the host system.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Failed</strong>: Retrieves work orders for which provisioning has failed.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Held</strong>: Retrieves work orders being held for review. These work orders require manual intervention to remove them from the Held state.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Failed in Translation</strong>: Retrieves work orders that the SRP was not able to translate.</td>
</tr>
<tr>
<td>Parm Label</td>
<td>Used to query a work order by parameter. If you search by parameter name, only the work orders with that parameter name appear. You can further refine the query by entering a specific value in the Parm Value field.</td>
</tr>
<tr>
<td>Network Element</td>
<td>Used to search for a network element host identified in the Common Service Description Layer (CSDL) and received by the SARM from the SRP. The host network element specified in this field is the one to which the last processed Atomic Service Description Layer (ASDL) is routed.</td>
</tr>
<tr>
<td>CSDL</td>
<td>Used to search for work orders containing the specified CSDL.</td>
</tr>
</tbody>
</table>
Searching for Work Orders

Table 3–1 (Cont.) Work Order Query Criteria

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent WO ID</td>
<td>The unique parent work order identifier. A parent work order must be provisioned before a dependent work order can be started.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date and time on which provisioning on this work order was scheduled to end. By default, the maximum date range is six days. If you do not use dates in your search criteria, you are not restricted to six days. For more information on using date and time properties, see “Using Date and Time Properties.”</td>
</tr>
<tr>
<td>Origin</td>
<td>The user ID or originating system ID. The value entered in this field must match the value entered in the Origin field of the Work Order Details page of the New Work Order window.</td>
</tr>
<tr>
<td>Parm Value</td>
<td>If you assign a value with the parameter name, work orders with the parameter name and value appear.</td>
</tr>
<tr>
<td>Workgroup</td>
<td>The organizational unit of the person or group to whom notification is sent should particular events occur on the work order.</td>
</tr>
<tr>
<td>Max Results</td>
<td>The maximum number of results you want returned.</td>
</tr>
</tbody>
</table>

Wildcard Characters
When searching for work orders, you can use the wildcard character % where applicable to represent any number of unknown characters.

Table 3–2 Wildcard Usage

<table>
<thead>
<tr>
<th>To search for...</th>
<th>Type...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All possible values for a field</td>
<td>%</td>
</tr>
<tr>
<td>All values that begin with h</td>
<td>h%</td>
</tr>
<tr>
<td>All values that begin with h and end with 2</td>
<td>h%2</td>
</tr>
</tbody>
</table>

Using Date and Time Properties
You can use date and time properties with all search criteria except WO ID to limit the query to a specific period.

To use date and time properties in a query:
1. In the OCA Console window, from the Provisioning Management menu, select Order Management.
   The Work Order Query window appears.
2. In the Start Date or End Date fields, click the ellipsis button.
   The Date/Time Properties dialog box appears.
3. Select the month from the list and the year using the scroll bar.
4. Select the date on the calendar.
   By default, the end date is set to the current day. Do not set the end date to a future date.
5. If necessary, select a specific time or accept the time that is displayed.
6. Click OK.
The new date and time are entered in the **Start Date** field.

### Selecting Sessions

The following procedure describes how to select a session. If ASAP is configured for multiple ASAP instances, you can select one or more systems to which the query search applies.

To select a session:

1. In the OCA Console window, from the **Provisioning Management** menu, select **Order Management**.
   
   The Work Order Query window appears.

2. In the Work Order Query window, from the **File** menu, select **Select Sessions**.
   
   The Select Sessions dialog box appears.

3. From the **Available Sessions** list, click the sessions that you want to search.
   
   The selected sessions appear in the **Selected Sessions** list.

4. Click **OK**.
   
   You are returned to the Work Order Query window within the selected sessions.

---

**Note:** The sessions shown in the **Selected Sessions** list are the sessions in the OCA configuration file that you have access to. To have access to multiple ASAP sessions, your system administrator must set up the same user ID and password for each ASAP instance that you require access to. If your ASAP instances do not have the same user ID and password, a warning message appears. Your system administrator sets up your user ID and password using the WebLogic Console in the ASAP_administrator group.

---

For more information on setting up user ID and password, refer to *ASAP Installation Guide*.

### Running Queries

When you have selected the appropriate session, you must specify the search criteria for your queries. After setting the search criteria, you can run the query.

Some search criteria can only be used alone or in conjunction with other specific criteria. For example:

- **WO ID** can only be used alone.
- **Parent WO ID** can only be used with **Start Date** and **End Date**.
- **Status**, **Start Date**, and **End Date** can only be used with:
  - **Origin** or **Workgroup**
  - **Parm Label** and **Parm Value** or **Network Element**

To run a query:

1. In the OCA Console window, from the **Provisioning Management** menu, select **Order Management**.
   
   The Work Order Query window appears.
2. In the Search Criteria section enter the appropriate search criteria. 
   For descriptions of the search criteria, see "Defining Query Criteria."

3. After specifying the search criteria for the query, from the Work Order menu, select Search.
   The search results appear in the Query Results section of the window.
   If you used Parent WO ID as a query parameter, you can query a work order’s descendents. To do so, select a row in the query results, right-click and select Search Descendants to find the work order’s descendents. This feature does not support multiple row selection.

4. You can now do the following:
   ■ Manage the search results including filtering, sorting, and exporting search results. See "Managing Search Results."
   ■ Correct work orders. See "Correcting Work Orders."
   ■ Handle corrected work orders. See "Handling Corrected Work Orders."

Saving Queries
You can save a query for future use.
To save a query:
1. In the OCA Console window, from the Provisioning Management menu, select Order Management.
   The Work Order Query window appears.
2. Enter the search criteria.
3. From the File menu, select one of the following:
   ■ Save Query: Updates a previously saved query that you have opened or saves a new query. If this is a new query, the Save Query dialog box appears, allowing you to save the query under a unique name. Enter the query name in the File Name field and click OK.
   ■ Save As Query: Saves the query you have opened under a unique name. In the Save Query dialog box, enter the query name in the File Name field and click OK.

Saving a Default Query
You can save a query as your default query. The search criteria of the default query appear automatically when you open the Work Order Query window.
To save your default query:
1. In the OCA Console window, from the Provisioning Management menu, select Order Management.
   The Work Order Query window appears.
2. Enter the search criteria.
3. From the File menu, select Save As (Default).
   The work order query is now the default query and the word “default” is added to the Search Criteria section title.
Managing Search Results

Running Saved Queries
You can retrieve a saved query and use it as the basis for a new search.

To run a saved query:

1. In the OCA Console window, from the **Provisioning Management** menu, select **Order Management**.
   The Work Order Query window appears.
2. In the Work Order Query window, from the **File** menu, select **Open Query**.
   The Confirm Open dialog box appears.
3. From the list of available queries, select the query you want to use.
   The name of the query appears in the **File Name** field.
4. Click **OK**.
   You are returned to the Work Order Query window. The query’s search criteria appear automatically in the Search Criteria section.
5. From the **Work Order** menu, select **Search**.
   The results appear in the Query Results section.

Canceling Queries
If the OCA is processing a query, you can cancel it.

To cancel a query:

1. In the OCA Console window, from the **Provisioning Management** menu, select **Order Management**.
   The Work Order Query window appears.
2. From the **Work Order** menu, select **Cancel Search**.

Managing Search Results
The OCA client provides several ways to manage search results.

- Filtering and unfiltering search results. See "Filtering and Unfiltering Search Results."
- Sorting search results. See "Sorting Search Results."
- Exporting search results to a file. See "Exporting Search Results to a File."
- Submitting a copy of the work order for provisioning. See "Submitting a Copy of a Work Order for Provisioning."
- Submitting a copy of the original work order for provisioning. See "Submitting a Copy of the Original Work Order for Provisioning."
- Configuring **Copy to Submit** and **Copy to Submit Original**. See "Configuring Copy to Submit and Copy to Submit Original."
- Saving a work order as a template. See "Saving a Work Order as a Template."

Filtering and Unfiltering Search Results
Use the filter option to remove search results that you do not want to work with.
To filter and unfilter search results:

1. In the Query Results section of Work Order Query window, select the cell containing the value that you want to filter on.

2. From the View menu, select Filter.

   The Query Results section displays only those work orders that contain the selected value.

3. (Optional) From the View menu, select Unfilter to restore the original search results.

**Sorting Search Results**

Use the sort option to order a selected column numerically or alphabetically in ascending or descending order.

To sort search results:

1. From the Query Results section of Work Order Query window, select the column or a cell in the column that you want to sort.

2. From the View menu, select Sort, then select Ascending or Descending, as required.

   You can click a column header to sort the column contents in ascending order.

**Exporting Search Results to a File**

You can export the search results to a file for processing in another software product.

To export search results to a file:

1. In the Work Order Query window, from the File menu, select Export Query to File, after you have run a query.

   The Export Query Results to File dialog box appears.

2. From the Look In list, select the location to which you want to save the file.

3. In the File Name field, enter the file name.

   The only file type is tab-delimited file format. In this format, the exported file contains fields separated by tabs.

4. Click Save.

**Submitting a Copy of a Work Order for Provisioning**

From the search results section of the Work Order Query window, you can copy an existing work order under a new work order ID, make changes, and submit it.

See "Configuring Copy to Submit and Copy to Submit Original" for configuration options.

To submit a copy of a work order for provisioning:

1. From the Query Results section of the Work Order Query window, select the work order you want to copy.

2. From the Work Order menu, select Copy to Submit.

   The New Work Order window appears, displaying the work order under a unique work order ID.
3. Make the required changes.
   For more information on creating new work orders, see "Creating Work Orders Using the Order Control Application."

4. Submit the work order for provisioning.
   For information on releasing work orders for provisioning, see "Releasing Work Orders for Provisioning."

### Submitting a Copy of the Original Work Order for Provisioning

From the search results section of the Work Order Query window, you can copy an existing work order’s original data under a new work order ID, make changes, and submit it.

The **Copy to Submit** command may produce a work order that is validated based on the data updated or inserted by the network element processor. To create a copy of a work order that preserves the original’s initial data, use **Copy to Submit Original**. The validation will only apply to those data fields defined from the original work order.

To obtain the work order’s data from its initial state, use either the **Original Work Order** menu command or the toolbar button on the New Work Order window.

See "Configuring Copy to Submit and Copy to Submit Original" for configuration options.

To submit a copy of the original work order for provisioning:

1. From the Query Results section of the Work Order Query window, select the work order you want to copy.

2. From the **Work Order** menu, select **Copy to Submit Original**.
   The New Work Order window appears, displaying the work order under a unique work order ID.

3. Make the required changes.
   For more information on creating new work orders, see "Creating Work Orders Using the Order Control Application."

4. Submit the work order for provisioning.
   For information on releasing work orders for provisioning, see "Releasing Work Orders for Provisioning."

### Configuring Copy to Submit and Copy to Submit Original

The **COPY_SUBMIT_MODE** configuration parameter is in the SARM section of the **ASAP.cfg** file. This file is located in the **ASAP_Home/config** directory, where **ASAP_Home** is the directory in which ASAP is installed.

- Set **COPY_SUBMIT_MODE** to 1 to enable **Copy to Submit**. This is the default.
- Set **COPY_SUBMIT_MODE** to 2 to enable **Copy to Submit Original**.
- Set **COPY_SUBMIT_MODE** to 3 to enable both **Copy to Submit** and **Copy to Submit Original**.

### Saving a Work Order as a Template

Templates contain default values for common, static work order entry parameters. With the work order template, you can quickly submit new work orders by editing
only the required parameters. You can save a template as a user or a global template. A user template is only accessible to the creator of the template. A global template is available to all users.

To save a work order as a template:

1. From the Query Results of the Work Order Query window, select the work order you want to save as a template.
2. From the Work Order menu, select Save As Template.
   
   The Template dialog box displays the work order header information, CSDLs, and the parameters for each CSDL.

3. Enable the corresponding Prompt to designate the CSDL parameters that can be modified in the Order Entry Wizard.

4. To save the template, from the File menu, select Save as.

   The Save Template As dialog box appears.

5. Do one of the following:
   - To restrict access to the template, click User.
   - To grant all users access to the template, click Global.

6. In the Template field, enter the template name and then click OK.

   You are returned to the Template dialog box. The name of the template appears in the title bar.

7. In the Template dialog box, from the File menu, select Exit.

   You are returned to the Work Order Query window.

### Wildcard Characters

When searching for work orders, you can use the wildcard character % where applicable to represent any number of unknown characters.

**Table 3–3  Wildcard Usage**

<table>
<thead>
<tr>
<th>To search for...</th>
<th>Type...</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All possible values for a field</td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>All values that begin with h</td>
<td>h%</td>
<td></td>
</tr>
<tr>
<td>All values that begin with h and end with 2</td>
<td>h%2</td>
<td></td>
</tr>
</tbody>
</table>

### Using Date and Time Properties

You can use date and time properties with all search criteria except WO ID to limit the query to a specific period.

To use date and time properties in a query:

1. In the OCA Console window, from the Provisioning Management menu, select Order Management.

   The Work Order Query window appears.

2. In the Start Date or End Date fields, click the ellipsis button.

   The Date/Time Properties dialog box appears.

3. Select the month from the list and the year using the scroll bar.
4. Select the date on the calendar.
   By default, the end date is set to the current day. Do not set the end date to a future date.

5. If necessary, select a specific time or accept the time that is displayed.

6. Click OK.
   The new date and time are entered in the Start Date field.

Selecting Sessions

The following procedure describes how to select a session. If ASAP is configured for multiple ASAP instances, you can select one or more systems to which the query search applies.

To select a session:

1. In the OCA Console window, from the Provisioning Management menu, select Order Management.
   The Work Order Query window appears.

2. In the Work Order Query window, from the File menu, select Select Sessions.
   The Select Sessions dialog box appears.

3. From the Available Sessions list, click the sessions that you want to search.
   The selected sessions appear in the Selected Sessions list.

4. Click OK.
   You are returned to the Work Order Query window within the selected sessions.

---

Note: The sessions shown in the Selected Sessions list are the sessions in the OCA configuration file that you have access to. To have access to multiple ASAP sessions, your system administrator must set up the same user ID and password for each ASAP instance that you require access to. If your ASAP instances do not have the same user ID and password, a warning message appears. Your system administrator sets up your user ID and password using the WebLogic Console in the ASAP_administrator group.

---

For more information on setting up user ID and password, refer to ASAP Installation Guide.

Correcting Work Orders

When you have identified one or more failed work orders and have investigated the cause of the provisioning failure, you can correct and resubmit the work order.

If you are working on more than one failed work order, you can move among the work orders by clicking the Previous Work Order Detail or the Next Work Order Detail buttons on the toolbar.

Before resubmitting a failed work order for provisioning, you must correct the failed work order parameter or CSDL. The following correction methods are described in this section:

- Locking and Unlocking Work Orders
Correcting Work Orders

- Retrying CSDLs
- Aborting CSDLs
- Inserting and Adding CSDLs
- Maintaining CSDL Parameters and Parameter Values
- Overriding Global Parameters
- Resequencing CSDLs
- Adding Extended Work Order Properties
- Modifying Extended Work Order Properties
- Deleting Extended Work Order Properties

In the work order details window, you cannot edit the information in the Global Parameters tab.

About Work Order Details

You can select work orders from the Work Order Query screen to view work order details.

Figure 3–2 shows the work order details screen.
The following sections describe the work order details tabs:

**About Work Order Details CSDL Tab**

This section provides information about the CSDL tab and sub tabs.

**About the CSDL Selection List**

You can select each CSDL contained in the work order from the CSDL selection list. When you select the other CSDL sub tabs reflect information relevant to the CSDL you selected.
About CSDL History Tab
The CSDL tab provides a CSDL History sub tab. You can enable the following options:

- **Show events**: Provides a response history returned from the NE as a result of MML commands or API calls sent to the NE as a result of a work order.
- **Show Switch History**: You can configure the ASDL Java or State Table implementation to return NE switch history parameters that ASAP stores in the `tbl_srq_log` database table, in the EVT_TEXT column. This switch history information displays when you select the Show Switch History option. For more information about the `tbl_srq_log` table, see the ASAP Developer’s Guide. For more information about enabling NE History at the Java implementation level, see the ASAP Cartridge Development Guide.

**Note**: You can augment the information provided in the CSDL History sub tab, by setting the `WO_AUDIT_LEVEL` parameter in the `ASAP_home/config/ASAP.cfg` to higher levels. Higher `WO_AUDIT_LEVEL` setting can have a negative performance impact. For more information about this parameter, see the ASAP Server Configuration Guide.

About CSDL Parameters Tab
The CSDL tab provides a CSDL Parameters sub tab. This tab describes the CSDL parameters that can be used by subsequence CSDLs within the same work order.

To enable the CSDL return parameter functionality, you must complete the following tasks:

1. You must configure the cartridge Java implementation associated with the ASDL that is returning information to support CSDL return parameters. You can implement these return parameters using the `ReturnCSDLParam` class. For more information, see the ASAP Cartridge Development Guide.
2. You must add CSDL parameters in the work orders you send that you expect to use in subsequent CSDLs within the same work order (see “Adding CSDL Parameter Values”).

About ASDL History Tab
The CSDL tab provide an ASDL History sub tab. This tab provide information about the ASDL that the SARM sends to the NEP. This information is maintained in the `tbl_asdl_log` database table. For more information about this table, see the ASAP Developer’s Guide.

Properties Tab
The CSDL tab provides an Properties sub tab. This tab provides information about individual CSDLs within a work order. This information is stored in the `tbl_srq_cSDL` database table. For more information, see the ASAP Developer’s Guide.

About Work Order Details Return Parameters Tab
The Return Parameters tab describes the Information parameters returned from a network element that the SARM returns to the originating order management system. These information parameters are stored in `tbl_info_param`. For more information, see the ASAP Developer’s Guide.
To enable the return information parameter functionality, you must configure the cartridge Java implementation associated with the ASDL that is returning information to support return information parameters. You can implement these return parameters using the **ReturnInfoParam** class. For more information, see the *ASAP Cartridge Development Guide*.

OCA displays return information in the **Return Parameters** tab, but does not do anything with the information, because the information is only useful for upstream order management system that originated the work order.

**About Work Order Details WO Properties Tab**

This tab provides details about the overall work order. ASAP stores this work order information in `tbl_srq_log` database table. For more information, see the *ASAP Developer’s Guide*.

**About Extended Work Order Properties**

This section provide a list of extended work order properties. This property is typically used by upstream order management systems to further describe the purpose of a work order. To configure extended work order values, see "Adding Extended Work Order Properties."

**About Work Order Details Global Parameters Tab**

The **Global Parameters** tab describes the global parameters that can be used by subsequence work orders.

To enable the Global return parameter functionality, you must complete the following tasks:

1. You must configure the cartridge Java implementation associated with the ASDL that is returning information to support Global return parameters. You can implement these return parameters using the **ReturnGlobalParam** class. For more information, see the *ASAP Cartridge Development Guide*.

2. You must add Global parameters in the work orders you send that you expect to use in subsequent work orders (see "Adding Global Parameters").

**Locking and Unlocking Work Orders**

When you make changes to a work order in the work order details window, ASAP automatically locks the work order to prevent other users from making changes until you are finished. When you must release the work order to the Provisioning, Hold, or Review queue, ASAP unlocks the work order. Java based SRPs including OCA SRP will not handle Review separately. They convert Review to Hold.

For more information on releasing work orders, see "Releasing Work Orders for Provisioning."

Only work orders with a status of Failed, Failed in Translation, Initial, Stopped, Review, and Held can be edited.

Before you begin updating a work order, refresh the work order to ensure that you are locking the most up-to-date record. In the work order details window, from the **Work Order** menu, select **Refresh**.

Users with administrative privileges can unlock work orders. Administrative privileges are defined using the WebLogic Console. To grant a user or group administration privileges, in the WebLogic Console, set the permission for a user or
Correcting Work Orders

group to SA_All. For more information on defining GUI interface security, refer to *ASAP System Administrator’s Guide*.

**Retrying CSDLs**

You can retry work orders by retrying individual failed CSDLs or all failed and unprovisioned CSDLs. Correcting the CSDL may not be required if the reason for the failure was network-related or equipment-related, rather than CSDL-related. When you retry one or more CSDLs, ASAP aborts the CSDL that caused the failure, copies it, and recreates it in the Initial state. You can then release the work order.

To retry an individual CSDL:

1. In the CSDL tab of the work order details window, select a CSDL whose status is Failed.
2. From the CSDL menu, select Retry.

   The original CSDL is aborted and a new CSDL appears. The status of the replacement CSDL is Initial.

3. From the Work Order menu, select Release.

   The Release dialog box appears.

   For information on the options available in the Release dialog box, see "Releasing Work Orders for Provisioning."

4. Make the required selections.
5. Select Now to release the work order immediately.
6. Click Release.

To retry all failed CSDLs:

1. In the work order details window, from the CSDL menu, select Retry Failed.
Correcting Work Orders

Managing Work Orders Using the Order Control Application

Each failed CSDL is aborted and replaced with a new CSDL. The status of the replacement CSDLs is Initial.

---

**Note:** If there are multiple ASDLs within a failed CSDL, only failed or rolled back ASDLs are retried. Completed ASDLs are skipped and the retry starts from the first ASDL that failed.

---

2. If there are no more corrections to be made, release the work order.

For information on the options available in the Release dialog box, see "Releasing Work Orders for Provisioning."

Aborting CSDLs

You can abort a failed or initial CSDL to retry the work order without that CSDL and without affecting successfully provisioned CSDLs. You can also abort all failed CSDLs in a work order.

To abort an individual CSDL:

1. In the CSDLs page of the work order details window, click the failed or initial CSDL.
2. From the **CSDL** menu, select **Abort**.
   
The status of the selected CSDL changes to **Aborted**.
3. If there are no more corrections to be made, release the work order.

For information on the options available in the Release dialog box, see "Releasing Work Orders for Provisioning."

Inserting and Adding CSDLs

You can insert or add one or more new CSDLs into work orders that have the following status:

- Failed
- Failed In Translation
- Held
- Initial
- Review (the status Review will be converted to Held in OCA GUI)
- Locked (only if locked by you)

When you insert a CSDL, you can specify its sequence relative to other CSDLs.

To insert CSDLs:

1. From the **CSDL** tab of the work order details window, select the CSDL above or below the one you want to insert the new CSDLs.
2. From the **CSDL** menu, select **Insert**, and then select **Before** or **After**, as required.
   
The Select CSDLs dialog box appears.
3. Click the CSDLs you want to insert in the specified location.
4. Click **OK**.
   
The selected CSDLs are inserted.
5. If there are no more corrections to be made, release the work order.

   For information on the options available in the Release dialog box, see "Releasing Work Orders for Provisioning."

To add CSDLs:
1. Click the CSDL tab of the work order details window.
2. From the CSDL menu, select Add.
   The Select CSDLs dialog box appears.
3. Click the CSDLs you want to add.
4. Click OK.
   The selected CSDLs are inserted at the end of the list of CSDLs. The added CSDLs have a status of Initial.
5. If there are no more corrections to be made, release the work order.

Maintaining CSDL Parameters and Parameter Values

All CSDLs consist of parameters that are defined when ASAP is installed and configured on your system. The OCA displays the parameters associated with a specific CSDL. You can define or modify the CSDL parameter values. You can only add a parameter if the CSDL has a status of Initial and is configured to allow the addition of CSDL parameters.

If you try to submit a work order with a missing required parameter value, an error message appears.

This section describes how to add CSDL parameters, modify CSDL parameter values, and delete optional CSDL parameters.

To add a CSDL parameter:
1. In the CSDL tab of the work order details window, select the CSDL to which you want to add an optional parameter.
2. In the CSDL information section of the CSDL tab, click the CSDL Parameters tab.
   The CSDL parameters already associated with the CSDL are displayed.
3. From the CSDL menu, select Parameter, then select Add.
   The CSDL Parameter dialog box appears.
4. From the list of parameters, select the optional parameter you want to add to the CSDL.
   The list displays only optional parameters that apply to the CSDL.
5. Enter the parameter value.
6. Click OK.
   The parameter is added to the CSDL Parameters tab.

To modify CSDL parameter values:
1. In the CSDL tab of the work order details window, select the CSDL that you want to modify.
2. In the CSDL information section of the CSDL tab, click the CSDL Parameters tab.
   The CSDL parameters already associated with the CSDL appear.
3. In the **CSDL Parameters** tab, select the CSDL parameter that you want to modify.

4. From the CSDL menu, select **Parameter**, then select **Update**.
   *The Input dialog box appears.*

5. In the **New Value** field, enter the new value.

6. Click **OK**.
   *The CSDL parameter value is updated in the **CSDL Parameters** tab.*

To delete an optional CSDL parameter:

1. In the **CSDL** tab of the work order details window, select the CSDL for which you want to modify a parameter.

2. In the CSDL information section of the **CSDL** tab, click the **CSDL Parameters** tab.
   *The CSDL parameters already associated with the CSDL are displayed.*

3. Click the optional CSDL parameter that you want to delete.

4. From the **CSDL** menu, select **Parameter**, then select **Delete**.
   *The selected CSDL parameter is deleted.*

### Overriding Global Parameters

You can override a global parameter to make it a local CSDL parameter and change the value.

To override a global parameter:

1. In the **CSDL** tab of the work order details window, select the CSDL for which you want to modify a parameter.

2. In the CSDL information section of the **CSDL** tab, click the **CSDL Parameters** tab.
   *The CSDL parameters already associated with the CSDL are displayed.*

3. From the **CSDL** menu, select **Parameter**, then select **OverGlobalPara**.
   *The Global Parameter dialog box appears.*

4. From the **Select a Global Parameter** list, select the global parameter you want to override.

5. Enter the new value of the global parameter.

6. Click **OK**.
   *The new CSDL parameter is added to the **CSDL Parameters** tab and overrides the global parameter.*

### Resequencing CSDLs

If a work order fails because of an incorrectly sequenced series of CSDLs, you can resequence the CSDLs before resubmitting the work order.

To resequence CSDLs:

1. Click the **CSDL** tab of the work order details window.

2. From the **CSDL** menu, select **Resequence**.
   *The Resequence – CSDL dialog box appears, displaying the CSDLs in their current sequence.*
3. Select the CSDL you want to appear first in the new sequence.
   The CSDL moves to the top of the Resequenced CSDLs section of the dialog box.
4. Select the next CSDL in the sequence.
   The CSDL appears after the first one in the Resequenced CSDLs section.
5. Repeat step 4 until all of the CSDLs appear in the Resequenced CSDLs section.
6. Click OK.
7. If there are no more corrections to be made, release the work order.
   For information on the options available in the Release dialog box, see "Releasing Work Orders for Provisioning."

### Adding Extended Work Order Properties

Extended work order properties are work order properties that you create. They are different from the work order properties that are already specified as a standard part of the work order (for example, work order timeout, retry, action etc.). Extended work order properties are only applicable to the work order where they are defined.

To add extended work order properties:
1. In the work order details window, click the **WO Properties** tab.
2. From **Extended Work Order Properties**, select **Add**.
   The Add Extended WO Property dialog box appears.
3. In the **Name** field, enter the name of the work order property.
4. In the **Value** field, enter the value of the work order property.
5. Click **OK**.
   The new work order property name and value are added to the Extended Work Order Properties section.

### Modifying Extended Work Order Properties

You can modify the value of an extended work order property that you have created.

To modify an extended work order property:
1. In the work order details window, click the **WO Properties** tab.
2. In the Extended Work Order Properties section, click the work order property that you want to modify.
3. From the **Extended Work Order Properties** menu, select **Update**.
   The Input dialog box appears.
4. In the **New Value** field, enter the value of the work order property.
5. Click **OK**.
   The new value of the work order property is displayed in the Extended Work Order Properties section of the **WO Properties** tab.

### Deleting Extended Work Order Properties

You can delete an extended work order property that you have created.
To delete an extended work order property:

1. In the work order details window, click the WO Properties tab.
2. In the Extended Work Order Properties section, click the work order property that you want to delete.
3. From the Extended Work Order Properties menu, select Delete.
   A message appears asking you to confirm the deletion.
4. Click Yes.
   The extended work order property is deleted.

Handling Corrected Work Orders

After you have corrected or updated work orders, you can handle them in different ways.

- If you searched for and corrected failed work orders, you can release them to the Provisioning queue.
- If you searched for work orders, but they require further investigation or review before they can be provisioned, you can place them on hold by sending them to the Review or Hold queue (in the Java based SRP including OCA, there is no separate Review. It will be converted to Hold).

The Hold and Review queues are essentially the same but can be used to differentiate between work orders that have to be reviewed for different reasons. For example, you can use the Hold queue for work orders that have failed because of facilities problems and the Review queue for work orders that have failed because of incorrect information.

After you have located the work orders you want to work with, you can perform the following procedures:

- Releasing Work Orders for Provisioning
- Placing Work Orders on Hold or Review
- Returning a Work Order to Its Previous State
- Canceling Work Orders
- Aborting Work Orders
- Stopping Work Orders

Releasing Work Orders for Provisioning

After you have corrected or updated a work order, you can release it for provisioning directly from the work order details window.

---

**Note:** You cannot release a locked work order that is being edited by another user. The work order can only be released by the user who originally locked it.

---

To release a work order to the Provisioning queue:

1. In the work order details window, search for the work order you want to release.
2. From the Work Order menu, select Release.
The Release dialog box appears.

3. Click **Provisioning** in the Work Order Queue section of the dialog box.

4. To resubmit the work order without the CSDL that caused the failure of the work order, click **Abort Last Failed CSDL**.

5. From the **Priority** list, select one of the following options:
   - **Low**: Work orders are submitted to the bottom of the Provisioning queue.
   - **Normal**: Work orders are processed after all high-priority work orders have been completed.
   - **High**: Work orders are moved to the top of the Provisioning queue.
   - **No Change**: Work orders are resubmitted to the Provisioning queue without a change in priority.

   To remove a work order from the Hold or Review queue, you must specify a priority other than **No Change**.

6. In the Activation Date/Time section, do one of the following:
   - To release the work order to the provisioning queue immediately, click **No Change** and then click **OK**.
   - To release the work order immediately, click **Now**.
   - To specify a time in the future to release the order, click **Change Due Date**.
     - In the **Due Date** field, click the ellipsis button. In the Date/Time dialog box, select the new date and time for the selected work order to be resubmitted to the Provisioning queue. The due date and time you choose must be in the future.

7. Click **Release**.

   The work is released for provisioning.

**Placing Work Orders on Hold or Review**

To place work orders on hold or review, release them to the Hold or Review queue. Work orders remain on hold or review until they are manually released for
provisioning. Java based SRP including the new OCA, there is no separate Review. The Review will be converted to Hold.

To put a work order on Hold or Review:

1. In the work order details window, search for the work order you want to release.
2. From the Work Order menu, select Release.
   The Release dialog box appears.
3. In the Work Order Queue section of the dialog box, click Hold or Review.
   The Priority and Activation Date/Time sections are disabled.
4. Click Release.
   The work order remains on hold or review until it is released from the queue.

Returning a Work Order to Its Previous State

You can automatically unlock the work order that you are updating and return it to the state it was in before you changed it.

To return a work order to its original state:

1. In the work order details window, from the Work Order menu, select Release.
   The Release dialog box appears.
2. In the Work Order Queue section of the dialog box, select Original.
   This can only be selected if the current work order status is locked. The Release dialog box appears.
3. Click Release.
   The work order reverts to the state it was in before you started updating it.

Canceling Work Orders

The Cancel Work Order command cancels existing orders. ASAP performs different actions on a work order depending on its status:

- Completed, Failed: All completed ASDLs are rolled back, the status of the work order is changed to Cancelled, and ASAP maintains a canceled record.
- Initial, Failed in Translation, Held, Review: The status of the work order changes to Cancelled.

You can also cancel In Progress and Stopped work orders. In both cases, the status of the work orders is changed to Cancelled.

When you cancel a work order, provisioning stops and any ASAP rolls back completed ASDLs which have rollback configured and rollback ASDLs defined. You can then edit the work order and resubmit it to the provisioning queue.

Cancel a work order when, for example, the work order is already in progress but should not be provisioned until a later date and time. However, if you try to cancel a work order with a Cancelled status, an error message appears. The work order is not affected.

The cancellation process is the same for all work orders.

In the case of work orders that have a parent-child relationship, ASAP breaks this relationship when the parent work order is cancelled. This behavior is based on the
notion that the parent-child relationship is a loosely coupled relationship; if the parent is canceled and the child orders have not been canceled, ASAP assumes that the parent order is no longer a required dependency for the children and that the child orders should no longer be dependent on the parent.

To cancel a work order:

1. In the Work Order Query window, select the work order you want to cancel.
2. From the **Work Order** menu, select **Cancel**.
3. Confirm the cancellation.

**Aborting Work Orders**

Aborting work orders stops the processing of CSDLs in work orders with one of the following status values:

- Initial
- Failed
- Failed in Translation
- Held
- Review

All CSDLs that are not completed at the time of the abort show a status of Aborted in the Work Order Query window. The abort process is the same for all work orders with any status listed above.

When you abort a work order, provisioning stops. You cannot resubmit the work order to any ASAP queue or edit it. To provision an aborted work order, you must recreate the work order and then submit it to the provisioning queue.

You abort a work order when it contains too many errors or problems and cannot be salvaged. In such situations it is often easier and more efficient to recreate the work order than to edit it.

You can abort individual or multiple work orders. The process is the same regardless of the number of work orders or their status.

To abort work orders:

1. In the Work Order Query window, retrieve the work orders you want to abort.
2. In the Query Results section, select the work orders to be aborted:
   - To select one work order, click it.
   - To select multiple work orders in a range, select the first one in the range and Shift-click the last work order in the range.
   - To select multiple work orders that are not in a range, Ctrl-click the work orders.
   - To select all work orders displayed in the Query Results section, from the **View** menu, select **Select All**.
3. From the **Work Order** menu, select **Abort**.
4. Confirm the action.

The selected work orders receive a status of Aborted and cannot be processed any further.
Stopping Work Orders

You can only stop work orders with a status of In Progress (for example, when their ASDLs have begun provisioning).

When you stop a work order, ASAP completes the current ASDL, stops processing the order, and assigns a Stopped status to it.

To restart a stopped work order, change its status to Initial or Cancelled.

Resubmitting a stopped work order with a new due date is not allowed because the work order is still sitting in the ASAP work order queue. If you need to rerun a stopped work order with a different due date, you must cancel the order and then resubmit it.

When you stop a work order, you can roll back completed CSDLs or stop the work order without rollback. Rolling back CSDLs that are not being provisioned returns them to a status of Initial.

You can stop individual or multiple work orders. The process is the same regardless of the number of work orders you are stopping.

---

**Note:** This procedure is normally restricted to System Administrators. It should only be used when work orders are causing system problems within ASAP.

---

To stop a work order:

1. In the Query Results section of the Work Order Query window, select the in progress work order you want to stop.
2. From the **Work Order** menu, select **Stop**, then do one of the following:
   - To rollback CSDLs that are completed, select **Rollback**.
   - To stop CSDLs that are in progress, select **No Rollback**.

To stop multiple work orders:

1. In the Work Order Query window, do one of the following:
   - To select all currently displayed work orders, from the **View** menu, select **Select All**.
   - To select a group of work orders, hold the Ctrl key and click the work orders.
2. From the **Work Order** menu, select **Stop**, then do one of the following:
   - To roll back all CSDLs that are completed, select **Rollback**.
   - To stop CSDLs that are in progress, select **No Rollback**.
Managing Fallout Work Orders Using the Order Control Application

Work orders can fail due to a number of factors including missing parameters, requests that are not valid, switch problems, or telephone lines that are in an unprovisionable state. Work orders that fail because of hard errors are called fallouts and can result in:

- Customer inconvenience
- Loss of business
- A network element remaining in an unsynchronized state

Oracle Communications ASAP can automatically correct soft errors, but it cannot correct hard errors. Hard errors must be analyzed to determine the cause of the fallout. After analyzing the fallout, you can identify what must be corrected or changed. The process of analyzing and correcting work orders is called fallout management.

To make the fallout management process more efficient, you can develop strategies for quickly analyzing and correcting failed work orders.

Your system administrator can set up ASAP to provide as much or as little detail about a problem as you need. If you find that the system error logs do not contain enough useful information, your system administrator can reconfigure the error logs.

**Determining the Cause of Work Order Failure**

The search function in the Order Control Application (OCA) enables you to search for failed work orders. Failed work orders are identified with a status of Failed or All Failed in the Status field of the Work Order Query window.

To determine the reason for a work order failure:

1. In the Work Order Query window, search for work orders with the status Failed, All Failed, or Failed in Translation.
   
   For more information on searching for work orders, see "Searching for Work Orders."

2. Select the work order you want to investigate.

3. In the Work Order Query window, from the Work Order menu, select Details.
   
   The work order details window appears.

4. Select the required Common Service Description Layer (CSDL) to view the CSDL parameters, CSDL and Atomic Service Description Layer (ASDL) history, and the work order properties.
Analyzing Fallouts

The results appear in the lower section of the CSDL tab.

5. When you have determined the reason for the work order failure, correct the error and resubmit the work order for provisioning.

---

Note: Instructions on correcting and releasing work orders are contained in the following sections.

---

Analyzing Fallouts

Analyzing fallouts is the most important step in the fallout management process. By analyzing a fallout, you can determine:

- Why the work order failed.
- Whether the problem can be corrected immediately, or if it can only be corrected by a network administrator.

To analyze fallouts, you can:

- Search for Failed or All Failed work orders in the Work Order Query window.
- Review the CSDL events displayed in the CSDL tab of the work order details window.
- Review CSDL details.
- Review the events listed for the work order to determine at what point in the provisioning process the failure occurred.
- Review the ASDL history and switch response logs to understand the point in the provisioning process at which the work order failed.

Common Fallout Scenarios

This section covers scenarios in which work orders fail during production. These examples are for reference only. The problems and messages you encounter depend on your implementation of ASAP.

Fallouts are caused by a number of factors. The most common scenarios are:

- Incorrect CSDL or global parameter values
- Unsynchronized data
- Improperly sequenced CSDLs
- Operational errors

---

Note: If a work order allows delayed failure, the order finishes processing before reporting the failure. In this case, you must carefully analyze the CSDL and ASDL history for each CSDL in the work order.

---

Scenario 1: Fallouts Caused by Incorrect Parameter Values

A work order can fail because of an incorrect CSDL parameter value. The incorrect value can be an invalid Line Equipment Number (LEN), an incorrect telephone number, etc.
For example, a service representative submits a work order to activate a new telephone line. When the work order reaches the Network Element (NE), the NE informs ASAP that the number is already in service, and the work order fails.

To correct incorrect parameter values:

1. Search for the failed order.
2. Select the failed work order in the Query Results section of the Work Order Query window.
3. From the Work Order menu, select Details.
4. Select the failed CSDL.
5. From the CSDL menu, select Retry.
   A copy of the CSDL (with the status of Initial) appears. The status of the failed CSDL has changed to Aborted.
6. Examine the CSDL history and ASDL history for the failed CSDL.
   For example, the CSDL history may indicate that the telephone number in the work order is already in use.
   Compare the Directory Number (DN) in the CSDL to the DN in the host system database. Potential causes of the fallout are:
   - The DN may have been incorrectly entered.
   - The number was disconnected, but no one entered this change into the system. Therefore, ASAP registers the DN as being in use.
   - The incorrect LEN may have been specified.
   - The number is still in use.
7. To update the CSDL parameter value, select the CSDL for which you want to modify a parameter.
   For more information on editing CSDL parameters, see "Retrying CSDLs."
8. In the CSDL information section of the CSDL tab, click the CSDL Parameters tab.
   The CSDL parameters already associated with the CSDL are displayed.
9. In the CSDL Parameters tab, select the CSDL parameter that you want to modify.
   From the CSDL menu, select Parameter, then select Update.
   The Input dialog box appears.
10. In the New Value field, enter the new value.
11. Click OK.
   The CSDL parameter value is updated in the CSDL Parameters tab.
12. Repeat steps 7 to 12 for each parameter you need to change. Do this only if the work order contains more than one incorrect parameter value.
13. After you have corrected all parameters, release the work order.
   For more information on releasing a work order to the provisioning queue, see "Releasing Work Orders for Provisioning."
Scenario 2: Fallouts Caused by Unsynchronized Data

A common cause of fallouts is unsynchronized data. This occurs when the following databases do not contain the same information:

- The host system database
- The Service Activation Request Manager (SARM) database
- The network element database

For example, a service representative submits a work order to add call waiting to a customer’s line. When the work order reaches the NE, call waiting is detected on that line and the order fails.

To correct unsynchronized data:

1. Search for the failed order.
2. In the Query Results section of the Work Order Query window, select the failed work order.
3. From the Work Order menu, select Details.
   The work order details window appears.
4. From the CSDL menu, select Retry.
   A copy of the CSDL (with the status Initial) appears below the original.
5. Examine the CSDL history and ASDL history.
   In this example, the switch response indicates call waiting was not added to the line.
6. Resubmit the work order.
   The work order completes, but no services are added.

At this point, information from the NE is sent back to the host system. The service representative can then determine when call waiting was activated on that line and, if necessary, why the customer has not been billed for this service.

Note: This type of problem is a soft error; it should not cause a fallout. If problems like this continue to occur, contact your development department. They can rewrite the appropriate ASAP State Table to ensure work orders do not fail when they encounter this type of error.

Scenario 3: Fallouts Caused by Improperly Sequenced CSDLs

CSDL events in a work order must be in a proper sequence. This sequence determines the correct order in which ASAP adds services to customer accounts. If CSDLs are not sequenced properly, the work order fails.

For example, a service representative submits a work order to:

- Add fax access to the line (with the CSDL C-CREATE_FAX_ACCESS).
- Create a new line (with the CSDL C-CREATE_BUS_LINE).

If the CSDLs are sequenced as above, the work order will fail because the CSDLs are not properly sequenced. You must activate a telephone line before you can add fax access to it.
To correct improperly sequenced CSDLs:

1. Search for the failed order.
2. In the Query Results section of the Work Order Query window, select the failed work order.
3. From the Work Order menu, select Details.
   The work order details window appears.
4. From the CSDL menu, select Resequence.
   The Resequence – CSDL dialog box appears with the CSDLs displayed in their current order.
   For more information on resequencing CSDLs, see "Resequencing CSDLs."
5. Resequence the CSDLs in their proper order.
   In this example, place C-CREATE_BUS_LINE before C-CREATE_FAX_ACCESS.
6. Click OK.
7. Release the work order to the provisioning queue.
   For more information, see "Releasing Work Orders for Provisioning."

Scenario 4: Fallouts Caused by Operational Errors

Operational errors can occur if:

- A new NE is added to the system but is not activated.
- There is a spelling mistake in the NE identifier.

When work orders fail because of operational errors, a message similar to the following one appears on Switch History/Events Property sheet of the Details – WorkOrder window:

Network Element Routing Error, Failed SRQ xxxx

Where xxxx is the number of the service request.

For example, due to a lack of available telephone numbers, a city using the 416 area code adds the 905 area code to its outlying regions. To handle the new area code, the telco adds a new NE but does not activate it. A service representative submits a work order to activate a line in the 905 area code. However, the work order fails because the NE to which the work order was routed is not operational.

To correct operational errors:

1. Search for the failed order.
2. In the Query Results section of the Work Order Query window, select the failed work order.
3. From the Work Order menu, select Details.
   The work order details window appears.
4. From the CSDL menu, select Retry.
   A copy of the CSDL (with a status of Initial) appears.
5. Examine the CSDL history and ASDL history. Because the problem was caused by an NE routing error, check the MCLI parameter in the CSDL Parameters tab of the
CSDL tab in the work order details window. Compare the name of the NE shown in the CSDL Parameters tab with a list of operational NEs.

In this example, the work order failed because the new NE was not activated. Therefore, ASAP views the NE as being non-existent.

6. Contact a network administrator to activate the required NE.
7. Click the failed CSDL, then from the CSDL menu, select Retry Failed.
   A copy of the CSDL (with the status of Initial) appears below the original.
8. Release the work order to the Hold or Review queue.
   For more information on releasing a work order, see "Releasing Work Orders for Provisioning."
9. When the NE is activated, release the work order to the provisioning queue.
   For more information, see "Releasing Work Orders for Provisioning."

Handling Other Provisioning Errors

This section discusses situations in which work orders fail, but in which detailed fallout management is not necessary. These situations are:

- A work order fails after it is corrected.
- Network elements become unavailable.
- Release of multiple work orders.

**A Work Order Fails after It Is Corrected**

After you have corrected a fallout, the work order may still fail. Possible reasons for the work order failure are:

- You corrected the problem but caused another problem.
- The work order contains several errors, some of which you may have missed.

To correct this problem:

1. Abort the work order, then re-enter it using either:
   - The OCA Order Entry function
   - The upstream order entry system
   For more information on the Order Entry function, see "Creating Work Orders Using the Order Control Application." For more information on releasing a work order, see "Releasing Work Orders for Provisioning."
2. Release the new work order to the provisioning queue.
   For more information, see "Releasing Work Orders for Provisioning."

**Network Elements Become Unavailable**

Network elements become unavailable:

- During scheduled NE blackout periods.
- When a connection to an NE is not established within a user-defined interval.
- When a port failure occurs.
When ASAP cannot establish a connection with an NE, work orders will time out but do not fail.

If NEs become unavailable, contact your network administrator to learn when the NE will become available. If another NE is available, you can edit the work order and then resubmit it to another NE.

**Releasing Multiple Work Orders**

When several work orders fail because of network problems, adjustments to individual work orders may not be required. You must release them to the provisioning queue when the network problem has been resolved.

Releasing a large number of work orders individually can be time consuming. However, with the OCA client, you can simultaneously release multiple work orders.

To release multiple work orders:

1. Search for the failed work orders in the Work Order Query window, then do one of the following:
   - To select all the failed work orders, from the **Work Order** menu, select **Select All**.
   - To choose multiple work orders, hold the Ctrl key and click the work orders to release.

2. From the **Work Order** menu, select **Release**.
   
   The Release dialog box appears.

3. Change the release settings as required and click **OK**.

4. Repeat step 3 for all work orders.
Using the Audit Log in the Order Control Application

This chapter provides information on the audit log feature of Oracle Communications ASAP Order Control Application (OCA).

The audit log records all events related to work order processing, such as completed or failed work orders.

In the Audit Log window, you can:

- Search the audit log
- Manage search results

To open the audit log:

1. In the OCA Console, from the Provisioning Management menu, select Audit Log.

   The Audit Log window appears.

   The Audit Log window consists of two sections:

...
Searching the Audit Log

This section describes how to do the following:

- **Selecting a Session**: Before you can run a query, you must select the sessions to search.
  - If you have access privileges to multiple OCA servers, you can include these servers in an audit log query, or you can restrict the search to specific servers only.
  - Perform the following procedure if you do not want to search the audit log for all sessions to which you have access. In this case, you would remove the session from the **Selected Sessions** list. Conversely, you can select an available session and return it to the **Selected Sessions** list.
  - To select a session:
    1. In the OCA Console, from the **Provisioning Management** menu, select **Audit Log**. The Audit Log window appears.
    2. In the Audit Log window, from the **File** menu, select **Select Sessions**. The Select Sessions dialog box appears, displaying all the sessions to which you have access.
    3. Do one of the following:
       - From the **Available Sessions** list, click the sessions that you want to include in the audit log query. The selected sessions appear in the **Select Sessions** list.
       - From the **Selected Sessions** list, click the sessions you do not want to include in the audit log query. Removed sessions appear in the **Available Sessions** list.
    4. Click **OK**. You are returned to the Audit Log window.

- **Searching the Audit Log**: After you have selected the sessions you want to search, you can enter and run an audit log query.
  - This section describes the query criteria you can use to search the audit log. You can use different combinations of search criteria to define a query. As well, you can use wildcards to represent any number of unknown characters.
After you have defined a query, you have the option to save it. Saved queries can be edited, renamed, or deleted.

**Search Criteria**
To restrict the search to specific audit log records, use as many known parameters as possible.

You can use the following query criteria to retrieve audit log records.

<table>
<thead>
<tr>
<th><strong>Table 5–1 Search Criteria</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>WO ID</td>
</tr>
<tr>
<td>Parent WO ID</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Parm Label</td>
</tr>
<tr>
<td>User ID</td>
</tr>
<tr>
<td>Start Date</td>
</tr>
<tr>
<td>End Date</td>
</tr>
<tr>
<td>Workgroup</td>
</tr>
<tr>
<td>Parm Value</td>
</tr>
<tr>
<td>Max Results</td>
</tr>
</tbody>
</table>

**Search Results**
The audit log displays the following search results:

<table>
<thead>
<tr>
<th><strong>Table 5–2 Search Results</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td>WO ID</td>
</tr>
<tr>
<td>User ID</td>
</tr>
</tbody>
</table>
Searching the Audit Log

When searching for audit log records, you can use the wildcard character % where applicable to represent any number of unknown characters.

**Table 5–3  Wildcard Character Usage**

<table>
<thead>
<tr>
<th>To search for...</th>
<th>type...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All possible values for a field</td>
<td>%</td>
</tr>
<tr>
<td>All values that begin with h</td>
<td>h%</td>
</tr>
<tr>
<td>All values that begin with h and end with 2</td>
<td>h%2</td>
</tr>
</tbody>
</table>

Running Queries

You can run queries by entering the appropriate query criteria (including wildcards, if necessary) and initiating the query. Query results appear in the Audit Log section of the Audit Log window.

To run queries:

1. In the Searching Criteria section of the Audit Log window, enter the appropriate search criteria.
   
   For descriptions of the search criteria, see "Search Criteria."

2. From the Work Order Event menu, select Search.

   The search results appear in the Audit Log section of the window.

To run a saved query:

1. In the Audit Log window, from the File menu, select Open Query.

   The Open Query dialog box appears.

2. From the list of available queries, select the query you want to use.

   The name of the query appears in the Query field.

3. Click OK.

   You are returned to the Audit Log window. The query’s search criteria appear automatically in the Searching Criteria section.

4. To initiate the search, from the Work Order Event menu, select Search.
The search results appear in the Audit Log section.

### Saving Queries

You can save a query that you have created for future use.

To save a query:

1. Enter the search criteria in the Searching Criteria section of the Audit Log window.
   
   For descriptions of the search criteria, see "Search Criteria."

2. From the File menu, select one of the following:
   
   - **Save Query**: Updates a previously saved query that you have opened or saves a new query. If this is a new query, the Save Query As dialog box appears, allowing you to save the query under a unique name. Enter the query name in the **Query** field and click **OK**.
   
   - **Save As Query**: Saves the query you have opened under a unique name. In the Save Query As dialog box, enter the query name in the **Query** field and click **OK**.

### Saving a Default Query

You can save a query as your default query. The search criteria of the default query appear automatically when you open the Audit Log window.

To save your default query:

1. Enter the search criteria in the Audit Log window.

2. From the File menu, select **Save As (Default)**.

   The audit log query is now the default query and the word "default" is added to the Searching Criteria section title.

### Canceling Queries

You can cancel an audit log query that the OCA is processing.

To cancel a query:

1. In the Audit Log window, from the **Work Order Event** menu, select **Cancel Search**.
   
   The Audit Log section displays the number of records retrieved up to the point of cancellation.

   The OCA displays a notification message that it is canceling the search.

2. Click **OK**.

### Managing Search Results

The OCA provides several methods of managing search results:

- Filtering and unfiltering search results
- Sorting search results
- Exporting search results to a file
Filtering and Unfiltering Search Results
Use the filter option to remove search results that you do not want to work with. For example, your search results may contain events with different SRQ Event Text values. You can select a specific value and use it as a filter. All audit log events that do not contain that SRQ Event Text value are removed from the search results.

To filter search results:
1. Run a query.
   The results appear in the Audit Log section of the Audit Log window.
2. In the Audit Log section, select the cell containing the value that you want to filter on.
3. From the View menu, select Filter.
   The Audit Log section displays only those work orders that contain the selected value.

To unfilter search results:
1. From the View menu, select Unfilter.

Sorting Search Results
Use the sort option to order a selected column numerically or alphabetically.

To sort search results:
1. Run a query.
   The results appear in the Audit Log section of the Audit Log window.
2. In the Audit Log section, select the column or a cell in the column that you want to sort.
3. From the View menu, select Sort, then select Ascending or Descending.
4. (Optional) Click a column header again to sort the column contents in original order.

Exporting Search Results to a File
You can export the search results to a file for processing in another software product, for example, Microsoft Word or Microsoft Excel.

The only file type is tab-delimited file format. In this format, the exported file contains fields that are separated by tabs.

To export search results to a file:
1. Run a query.
   The results appear in the Audit Log section of the Audit Log window.
2. From the File menu, select Export to File.
   The Export Query Results to File dialog box appears.
3. From the Look in list, select the location to which you want to save the file.
4. In the File name field, enter the file name.
5. Click Save.
   The search results are saved to the specified location.
You can use the event notification function in the Oracle Communications ASAP Order Control Application (OCA) to receive work order event notifications as they occur on a specified ASAP system. An event is a change in the status of a work order during provisioning. The components for setting up and viewing work order events are:

- The Event Management dialog box, where you can subscribe to work order notifications for a specific ASAP system, based on event type.
- The Events Message Board window, which displays work order events occurring on the ASAP system according to the criteria you have defined in the Event Management dialog box. After the work order is submitted, the events appear on the Events Message Board window. When accessed from the Events Message Board window, the work order properties window contains a **WO Events** tab.

The Events Management dialog box contains the following event types:

- WO Accept
- WO Complete
- WO Estimate
- WO Other
- WO Soft Error
- WO Timeout
- WO All
- WO Complete Failure
- WO Failure
- WO Rollback
- WO Startup
- NE Unknown

**Subscribing to Events Management**

You can subscribe to work order notifications based on event type.

When you no longer require work order event notifications, you can unsubscribe from the events notification.
To subscribe to work order events notification:

1. In the OCA Console, from the **Events** menu, select **Events Management**.
   The Event Management dialog box appears.
2. From the **ASAP System** list, select the ASAP system that you want to receive notifications for.
3. Select the appropriate value from the **Event Type** list if you want to receive notifications for specific work order events.
4. Click **Subscribe**.
   Your settings are saved and you begin to receive event notifications in the Events Message Board window.

### Viewing Event Notifications

After you have subscribed to the events notification, you can open the Events Message Board window to view notifications of work order events as they occur.

***Note:*** OCA does not retain subscription information after you log off. You must resubscribe to the events notification when you start a new session.

To view the Events Message Board window:

1. In the OCA Console, from the **Events** menu, select **Events Message Board**.
   The Events Message Board window appears, displaying work orders on specified ASAP system, the event, and the time of the event.
2. Double-click the event for which you want to view details.

The work order details window appears.

The title of the window displays the work order ID and the ASAP system that the order is being processed on.

3. Click the **WO Events** tab to view the work order events in the work order details window.
4. Click the tabs on the left-hand side of the WO Events property sheet to view the details of each event. Each tab corresponds with an event.

Only events that are applicable to the work order are accessible. For example, if the work order has processed correctly, the WO Accept, WO Startup, and WO Complete tabs are accessible. The remaining work order events are not applicable and are therefore not accessible. This example shows an incomplete work order; therefore, the WO Startup, WO Failure, and WO rollback tabs are accessible and the other tabs are not applicable.
This chapter provides an overview of Oracle Communications ASAP Reports that are implemented with Oracle Business Intelligence (BI) Publisher. The chapter also provides information on how to install, upload, and view ASAP reports.

You can install Oracle BI Publisher report templates as part of the ASAP client installation. You can view reports in Oracle BI Publisher Enterprise using a web based URL. For more information on ASAP client installation, see the ASAP Installation Guide.

About Standard ASAP Reports

Table 7–1 lists the reports that are standard to ASAP and the necessary information to view them.
## Table 7–1  Standard ASAP Reports

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Source Type</th>
<th>Table Name</th>
<th>Required Information</th>
<th>Information Included</th>
<th>Sorting Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aborted Work Orders Report</td>
<td>SARM</td>
<td>tbl_wo_audit</td>
<td>Start and End dates and times of the report</td>
<td>Work Group name</td>
<td>Ascending order by: Work Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Name of the Work Group(s) from which to retrieve a specific Work Group detail</td>
<td>ID of the user who aborted the work order</td>
<td>User ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Order type</td>
<td>Date and time</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Work Order ID number</td>
<td>Work order ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Due date</td>
<td></td>
</tr>
<tr>
<td>Activity Report</td>
<td>ADMIN</td>
<td>tbl_perf_order</td>
<td>The Report Type to be generated based on the selected option.</td>
<td>Work Group name</td>
<td>Ascending order by: Work Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Select P to generate a report for polling records</td>
<td>Date</td>
<td>Date and time of each record</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Select S to generate a report for summary records</td>
<td>Number of work orders received</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of work orders that are future dated</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of completed work orders</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of failed work orders</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of cancelled work orders</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Percentage of work orders failed</td>
<td></td>
</tr>
<tr>
<td>ASDL Details on ASDL Command(s) Report</td>
<td>ADMIN</td>
<td>tbl_perf_asdl</td>
<td>Start and End dates and times of the report</td>
<td>ASDL Name</td>
<td>Ascending order by: ASDL name</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Name of the ASDL(s) from which to retrieve a specific ASDL detail</td>
<td>Date received</td>
<td>Date and time of each record</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of ASDL(s) received</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of ASDL(s) completed</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of ASDL(s) failed</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Average time for the ASDL to complete</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Maximum time for the ASDL to complete</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Minimum time for the ASDL to complete</td>
<td></td>
</tr>
</tbody>
</table>
### Table 7–1  (Cont.)  **Standard ASAP Reports**

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Source Type</th>
<th>Table Name</th>
<th>Required Information</th>
<th>Information Included</th>
<th>Sorting Order</th>
</tr>
</thead>
</table>
| ASDL Detail on Network Element(s) Report | ADMIN       | tbl_perf_ne  | Start and End dates and times of the report  
Name of the NE(s) from which to retrieve statistical ASDL detail | Network Element name  
Date received  
Number of ASDL received for the NE  
Number of completed ASDLs for the NE  
Number of failed ASDLs for the NE  
Average time to complete ASDLs for the NE  
Maximum time to complete ASDLs for the NE  
Minimum time to complete ASDLs for the NE | Ascending order by:  
Network Elements  
ASDL names  
Date and time of each record |
| CSDL(s) Detail Report | ADMIN       | tbl_perf_csd | Start and End dates and times of the report  
Name of the CSDL(s) from which to retrieve statistical CSDL detail | CSDL name  
Date received  
Number of CSDLs received  
Number of CSDL completed  
Number of CSDL failed  
Average time to complete CSDL  
Maximum time to complete CSDLs  
Minimum time to complete CSDLs | Ascending order by:  
CSDL name  
Date and time of each record |
| Last Activity Report | ADMIN       | tbl_perf_order | The Report Type to be generated based on the selected option.  
- Select P to generate a report for polling records  
- Select S to generate a report for summary records  
Name of the Work Group(s) from which to retrieve a specific Work Group detail | Work Group name  
Number of work orders received  
Number of work orders that are future-dated  
Number of completed work orders  
Number of failed work orders  
Number of cancelled work orders  
Percentage of work orders that failed | Ascending order by Work Group. |
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Source Type</th>
<th>Table Name</th>
<th>Required Information</th>
<th>Information Included</th>
<th>Sorting Order</th>
</tr>
</thead>
</table>
| Last ASDL Detail on ASDL Command(s) Report | ADMIN | tbl_perf_asdl | Name of the ASDL(s) from which to retrieve a specific ASDL statistical information | ASDL name  
Number of ASDLs received  
Number of ASDLs completed  
Average time (in seconds) for the ASDL to complete  
Maximum time (in seconds) for the ASDL to complete  
Minimum time (in seconds) for the ASDL to complete | Ascending order by ASDL name. |
| Last ASDL Detail on Network Element(s) Report | ADMIN | tbl_perf_ne | Name of the NE(s) from which to retrieve statistical ASDL detail | Network Element name  
Number of ASDLs received for the NE  
Number of completed ASDLs for the NE  
Number of failed ASDLs for the NE  
Average time to complete ASDLs for the NE  
Maximum time to complete ASDLs for the NE  
Minimum time to complete ASDLs for the NE | Ascending order by Network Elements. |
| Last CSDL(s) Detail Report | ADMIN | tbl_perf_csdl | Name of the CSDL(s) from which to retrieve statistical CSDL detail | CSDL name  
Number of CSDLs received  
Number of completed CSDLs  
Number of failed CSDLs  
Average time to complete CSDLs  
Maximum time to complete CSDLs  
Minimum time to complete CSDLs | Ascending order by CSDL name. |
| Last Soft Error Report | ADMIN | tbl_perf_ne_asdl | Name of the NE(s) from which to retrieve soft error detail | Network Element name  
ASDL name  
User Error description  
Number of soft errors | Ascending order by:  
Network Element  
ASDL  
User error |
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Source Type</th>
<th>Table Name</th>
<th>Required Information</th>
<th>Information Included</th>
<th>Sorting Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Switch Error History Report</td>
<td>ADMIN</td>
<td>tbl_perf_ne_asdl</td>
<td>Name of the NE(s) from which to retrieve switch history detail</td>
<td>Base Error type</td>
<td>Ascending order by: Base type, Network Element, ASDL name, User error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Element name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ASDL Command</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>User Error description</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of errors</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of NE errors</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Total number of base errors</td>
<td></td>
</tr>
<tr>
<td>Soft Error Report</td>
<td>ADMIN</td>
<td>tbl_perf_ne_asdl</td>
<td>Start and end date of the report</td>
<td>Network Element name</td>
<td>Ascending order by: Network Elements, ASDL, User error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Name of the NE(s) from which to retrieve soft error detail</td>
<td>Date Received</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>User Error description</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of soft errors</td>
<td></td>
</tr>
<tr>
<td>Switch Error History Report</td>
<td>ADMIN</td>
<td>tbl_perf_ne_asdl</td>
<td>Start and end date of the report</td>
<td>Base error type</td>
<td>Ascending order by: Base type, Network Element, ASDL name, User error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Name of the NE(s) from which to retrieve switch error history detail</td>
<td>Network Element name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ASDL Command</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Date received</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>User error description</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number of errors</td>
<td></td>
</tr>
<tr>
<td>Work Order Status Report</td>
<td>SARM</td>
<td>tbl_sq</td>
<td>Start and End dates and times of the report</td>
<td>NE name</td>
<td>Ascending order by: Network Element, Status of the Work Order, Provisioning date of order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tbl_wrk_ord</td>
<td>The name of the NE(s) from which to retrieve work order status detail</td>
<td>Work order ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>tbl_event_queue</td>
<td>Work Order Status</td>
<td>Work order due date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Work order status (All, Pending, Completed, Cancelled, Failed, Stopped, or Other)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Description of due date (Past Due, Due Today, or Future Dated)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work Order Summary Report</td>
<td>SARM</td>
<td>tbl_wrk_ord</td>
<td>Start and End dates</td>
<td>Number of completed WO's</td>
<td>Ascending order by: Status of the Work Order, Provisioning date of order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tbl_event_queue</td>
<td>Name of NE (optional)</td>
<td>Number of completed WO's with soft fail</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>tbl_sq</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work Order Summary by NE Report</td>
<td>SARM</td>
<td>tbl_wrk_ord</td>
<td>Start and End dates</td>
<td>Number of completed WO's</td>
<td>Ascending order by: Network Element, Status of the Work Order, Provisioning date of order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tbl_event_queue</td>
<td>Name of NE (optional)</td>
<td>Number of completed WO's with soft fail</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>tbl_sq</td>
<td></td>
<td>Number of failed WO's</td>
<td></td>
</tr>
</tbody>
</table>
Installation Overview

To set up your system to run ASAP reports, perform the following tasks:

1. Installing and Configuring BI Publisher
2. Installing ASAP Report Templates

Installing and Configuring BI Publisher

To set up BI Publisher, you need the following:

- Administrator privileges on the computer where you install BI Publisher Enterprise. The administrators can assign user rights. Depending on the rights administrators give to themselves and to others, users can customize reports based on the available parameters or schedule reports to run.
- BI Publisher Enterprise license

Installing BI Publisher

To install BI Publisher, download the software for the version specified in ASAP Installation Guide and follow the installation instructions in the BI Publisher documentation.

Setting Up Users for SARM and ADMIN Databases

Before you can access BI Publisher, you must create user IDs and passwords for the Service Activation Request Manager (SARM) and ADM databases. You must provide...
users with select access to the tables in these databases. For more information on setting up user IDs and passwords for SARM and ADM databases, see the ASAP Installation Guide.

You must ensure that the following servers are running:

- ADM
- SARM

To set up database user IDs and passwords:

- You can give users the environment user IDs to access the databases. However, in most cases, set up separate reporting user IDs with only select access.
- You must set up separate user IDs for different ASAP environments because you cannot use the same one across different environments.
- You should limit the number of users with select access on SARM tables to avoid degrading ASAP performance.

**Configuring JDBC Data Sources**

For the ASAP report to run in BI Publisher, you need to configure data sources for the Admin and SARM databases.

To configure JDBC data sources for Admin and SARM databases:

1. Log in to BI Publisher with administrator’s privileges using the following URL:
   \[ http://ip\_address:port/xmlpserver \]
   
   Where \( ip\_address \) and \( port \) are the IP address and port of the BI Publisher server. The Home screen appears.

2. Click Administration.
   
   The Administration screen appears.

3. Under Data Sources, click JDBC Connection.
   
   The Data Sources screen appears.

4. In the JDBC tab, click Add Data Source.

5. Enter the following fields for the new connection:
   
   a. In the Data Source Name field, enter a name to represent the data source. Oracle recommends entering ADM_DS and SARM_DM for the Admin and SARM databases respectively.
   
   b. From the Driver-Type list, select the database type.
      
      When you select a driver type, BI Publisher will automatically display the appropriate database driver class as well as provide the appropriate connection string format for your selected database.
   
   c. You can update the Database Driver Class field if required.
   
   d. In the Connection String field, enter the database host, port, and SID details.

---

**Note:** Repeat the following steps for each database. For example, configure a JDBC data source for the ADMIN database, then repeat for the SARM database.
Installing ASAP Report Templates

You must install the ASAP report templates before uploading on BI Publisher. For more information on installing the report templates, see the ASAP Installation Guide.

**Note:** If you select the OCA thick client installation type as Custom, ensure that you select Report.

The reports templates are installed in the following directory:

`ASAP_client_destination\BIReports`

For example:

`C:\Program Files\Oracle Communications\ASAP\BIReports`

Uploading and Configuring ASAP Reports

To upload and configure ASAP reports on BI Publisher:

1. Log in to BI Publisher with administrator’s privileges using the following URL:
   
   ```
   http://ip_address:port/xmlpserver
   ```
   
   Where `ip_address` and `port` are the IP address and port of the BI Publisher server. The Home screen appears.

2. Click the Catalog tab.

3. Click the My Folders folder in which you want to upload the report.

4. On the left-hand side of the window, under Tasks, click Upload.

5. Click Browse.

   The Choose file dialog box appears.

6. From the list, select the `.xdoz` file for the specific report which you want to upload.

   For example, if you are uploading the Activity Report, choose the `Activity_Report.xdoz` file from the `ASAP_client_destination\BIReports\Activity Report` directory.

7. Click Open, then click Upload.
8. Repeat steps 4 to step 7 for the .xdmz data model file for the specific report which you want to upload.

   For example, if you are uploading the Activity Report, choose the Activity_Report.xdmz file from the ASAP_client_destination\BIRoots\Activity Report directory.

9. Click Edit, for the newly uploaded .xdmz data model file.

10. Verify that the Default Data Source is pointing to the appropriate data source for the report.

    The current report must point to the Admin data source or SARM data source. For more information on appropriate data sources for each report, see "About Standard ASAP Reports."

11. Click the Save icon.

12. Click Catalog.

13. Click Edit for the newly uploaded .xdoz report.

14. Click the Choose existing Data Model search icon below the report heading.

15. Select the corresponding .xdmz data model for the .xdoz report.

16. Click the Save icon.

Viewing ASAP Reports

You can generate the reports after uploading them on BI Publisher. For this, you can click Open on the specific report. You can view the generated reports using BI Publisher.

You can customize (filter) the reports based on the available parameters like Start Date, End Date, and so on. The availability of the parameters depends on the report.

Exporting Reports

You can choose a directory where you wish to save a report. The report can be saved in different formats namely, HTML, PDF, RTF, CSV, DATA (which is saved as a .xml file), and so on. The availability of formats depends on the report template.

To export a report:

1. Upload a specific report and its corresponding report template. For information on uploading reports, see "Uploading and Configuring ASAP Reports."

2. Click the Catalog tab.

3. From MyFolders, open the folder containing the uploaded ASAP reports.

4. Click Open on the report you want to view.

5. Specify the parameters for the report like Start Date, End Date, and so on. See Table 7–1, "Standard ASAP Reports" for more information on the parameters.

6. Click View to view the generated report.

7. Click Export.

8. Save the report on your local machine.
Printing Reports

To print a report to a printer:

1. On the generated report window, select the required report format like HTML, PDF, RTF, and so on.

2. Click Export to save the report onto your local machine. For more information on exporting reports, see "Exporting Reports."

3. Use the print option, to print the report, as available by the report format.

For information on scheduling and analyzing, see Report Designer’s Guide in the BI Publisher documentation. For information on sending documents by e-mail, see Administrator’s and Developer’s Guide in the BI Publisher documentation.